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1 SchemaAgent 2006

SchemaAgent™ 2006 is an Altova technology that enables you to manage multiple schemas
and build relationships between schemas from within a GUI. SchemaAgent also provides a
display of relationships between Altova MapForce Design (MFD) files and their associated
schemas. 

Altova's SchemaAgent technology consists of two components: a SchemaAgent server (local or
network-based) and a SchemaAgent Client. A SchemaAgent server serves W3C XML schemas
and MFD files to one or more SchemaAgent Clients on the network. The SchemaAgent Client is
an application with a GUI that provides access to the schemas served by a SchemaAgent
server. Using standard GUI mechanisms, such as copy-and-paste and drag-and-drop, 
SchemaAgent Client users are able to easily build relationships between the served schemas
and to make large-scale changes—such as in path references—across multiple schemas.
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2 About this Documentation

This document provides an overview of how SchemaAgent technology works, and describes
how to use the SchemaAgent server and SchemaAgent Client together. It also provides an
overview of how Altova's XMLSpy application (Enterprise and Professional Editions) can utilize
SchemaAgent technology to provide powerful schema editing and management capabilities.

This document is divided into the following parts:
 

· An introduction to SchemaAgent and its mechanism.
· A SchemaAgent tutorial.
· A description of the installation, configuration, and use of SchemaAgent Server .
· A description of the installation, configuration, and use of SchemaAgent.
· An overview of the usage of XMLSpy Enterprise and Professional Editions as

SchemaAgent clients.
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3 Introduction

Altova's SchemaAgent technology consists of two components: a SchemaAgent server and a
SchemaAgent Client. A SchemaAgent server is installed either:

 

· on the same machine as a SchemaAgent Client, where it serves that client (
LocalServer version, installed with SchemaAgent); or 

· on a network, from where it can serve multiple clients (SchemaAgent Server, separate
installation from SchemaAgent).

SchemaAgent terminology
The product names and the naming conventions used in this documentation are as follows:

 

· There are two (separately downloadable) products: (i) Altova SchemaAgent™ 2006 (
SchemaAgent for short), and (ii) Altova SchemaAgent Server™ 2006 (SchemaAgent
Server for short).

· The SchemaAgent product comprises a SchemaAgent LocalServer (LocalServer for
short) and a SchemaAgent Client. The LocalServer serves the SchemaAgent Client on
that machine.

· SchemaAgent Client connects to a server, which can be either (i) LocalServer (installed
with SchemaAgent Client as part of the Altova SchemaAgent product), or (ii)
SchemaAgent Server (installed separately from Altova SchemaAgent).

· SchemaAgent Server can be installed on a network and can serve multiple
SchemaAgent Clients.

· SchemaAgent technology can also be used in Altova's XMLSpy® 2006 product
(Enterprise and Professional Editions). XMLSpy communicates via SchemaAgent Client
with either LocalServer or SchemaAgent Server.
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3.1 SchemaAgent in the Altova Product Range

Please note the following important product-related information.
 

· Both SchemaAgent Server and SchemaAgent are to be downloaded separately from
the SchemaAgent download page at the Altova website and installed separately.

· SchemaAgent Server is available free of charge.
· SchemaAgent requires a license that must be purchased from Altova. 
· In order to use SchemaAgent with XMLSpy, SchemaAgent must be installed on the

same machine as XMLSpy. SchemaAgent Server can be installed anywhere on the
network. Once SchemaAgent Server and SchemaAgent are correctly installed, XMLSpy
will automatically make the necessary associations.

· Altova's Enterprise XML Suite and Professional XML Suite products include the 
SchemaAgent product and a license key for it.  The SchemaAgent Server application,
however, is not included as part of the Altova XML Suite packages, and must be
downloaded from the SchemaAgent download page at the Altova website.

· XMLSpy Enterprise Edition and XMLSpy Professional Edition (when purchased
independently of Altova's XML Suite applications) can both use SchemaAgent. To do
this, you must (i) download and install SchemaAgent with a valid license on the same
machine as XMLSpy, and (ii) optionally, download and install the free SchemaAgent
Server application anywhere on your network.

Important: Any SchemaAgent or SchemaAgent-related product from Altova (including XMLSpy
) starting with Version 2005 release 3 is not compatible with versions of SchemaAgent or
SchemaAgent-related products previous to it.

http://www.altova.com/download_schemaagent.html
http://www.altova.com/download_schemaagent.html
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3.2 Working with SchemaAgent

The basic mechanism for working with SchemaAgent is as follows:
 

1. In a SchemaAgent server, you define one or more search paths. A search path is the
path to a folder on the network. Once search paths have been defined, the server
builds an internal map of the relationships between all schemas and Altova MapForce
Design (MFD) files in the defined search paths. It is these schemas and MFD files that
are served to SchemaAgent Clients.

2. A SchemaAgent Client displays served schemas and MFD files in its Explorer pane in a
hierarchical tree view and as a list of schemas and MFD files organized by folder. You
can use commands available in this pane to manage schemas (rename, move, delete,
etc). The advantage is that multiple schemas can be managed from within the 
SchemaAgent Client GUI, thus obviating the need to edit individual schemas
separately.

3. In the Design Pane of SchemaAgent Client, you can create designs of schemas (
SchemaAgent Designs) that enable you to build relationships between various schemas
in the search paths defined for the connected SchemaAgent server. These designs can
be saved as SchemaAgent Design files for subsequent editing. Once a relationship is
created or modified in a SchemaAgent Design, that relationship is physically written into
the relevant schema (.xsd) file/s and any related schema file. To undo a modification
to a relationship, you must edit the SchemaAgent Design accordingly.

4. In the Design Pane, you can obtain a graphical view of the relationships between an
MFD file, its source and target schemas, and all schemas associated with the source
and target schemas.

5. If Altova's XMLSpy has been set up to use SchemaAgent technology, the components
of other schemas in the search path can be accessed and reused within the schema
currently being edited in XMLSpy.
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3.3 Features of SchemaAgent

The features of SchemaAgent technology are listed below under three headings: SchemaAgent
Server, SchemaAgent Client, and XMLSpy and SchemaAgent. The main SchemaAgent
technology features are in the SchemaAgent Client section and in the XMLSpy and
SchemaAgent section. In addition to listing the features of the technology as a whole, each
section lists features that are specific to that product. Note, however, that SchemaAgent Server
and SchemaAgent Client work together, and that, in order for XMLSpy to use SchemaAgent,
both SchemaAgent Server and SchemaAgent Client must be installed.

SchemaAgent Server
The following list of SchemaAgent Server-specific features relates mostly to SchemaAgent
Server communications and GUI functionality. 

 

· SchemaAgent Server can be installed as a standalone application with a GUI, or as an
interactive or non-interactive service.

· SchemaAgent Server processes client requests to create, update, or delete schema
IIRs (Includes, Imports, and Redefines) and manages client–server communication. It
also processes all file-based manipulations: create, delete, move, and rename.

· GUI provides full environment information, including lists of currently connected clients
and all defined search paths.

· GUI has a window pane displaying all defined search paths as hierarchical tree
structures and all schemas and MFD files within these search paths.

· GUI has a log window in the GUI that displays detailed communications activity.
· Log reports can be configured and written to files.
· Easy-to-use search path selection using Explorer-type browse functionality.
· Enables access to schemas located in WebDAV folders on (secure) WebDAV servers

with UNC paths and drive letters.

SchemaAgent Client
SchemaAgent Client provides a GUI that enables you to build schema relationships and
manage large numbers of schemas, as well as view relationships between MFD files and their
associated schemas. These are the core features of SchemaAgent technology. In addition,
SchemaAgent Client provides user-friendly GUI features. With SchemaAgent Client you can do
the following:

 

· Manage single or multiple schemas as schema components in a graphical workspace.
· Create schema designs that help to manage and organize schema collections

intuitively.
· Create, update, or delete IIRs (Includes, Imports, and Redefines) between schemas by

direct manipulation in a SchemaAgent Design using drag-and-drop. IIR changes are
passed on to all related schemas.

· If a schema is renamed or moved, the change is passed to all other files in the
workspace that reference the changed schema.

· In a SchemaAgent Design, view IIRs immediately and in greater detail in the schema
component itself.

· In a SchemaAgent Design, view the detailed structure of schema components, such as
elements and complex types.

· Select or insert schemas that reference other schemas in the workspace.
· View the relationships between MFD files and their associated schemas.

XMLSpy and SchemaAgent
If set up to work with SchemaAgent, Altova's XMLSpy provides powerful schema editing
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capabilities.
 

· While a schema is being edited in the Schema/WSDL View of XMLSpy, components of
all schemas in SchemaAgent Server's search paths are listed in the Entry Helpers and
can be modified and reused in the schema being edited.

· Information about IIRs created or modified in Schema/WSDL View is written to related
schemas.
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4 SchemaAgent Tutorial

This document explains, step-by-step using examples, how to set up and use SchemaAgent to
create include, import and redefine relationships between XML schemas.
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4.1 Introduction

This tutorial does the following:
· Describes installation of SchemaAgent Client
· Explains how to connect to the SchemaAgent local server
· Explains how to configure a path to the Examples folder, which contains the

examples used in the tutorial
· Shows you how to create include, import and redefine relationships between XML

schemas using SchemaAgent Client
· Shows you how to include, import and redefine types from one XML schema in

another XML schema using XMLSpy
· Shows you how to view relationships between XML schemas, and how to view

MapForce files
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4.2 Setting Up SchemaAgent Client

In this part of the tutorial you will install SchemaAgent Client, connect to the SchemaAgent local
server, and configure a path to the folder that contains the examples for this tutorial.

Installing SchemaAgent Client
When you install SchemaAgent Client, both the client and the LocalServer are installed.

Please note: To use the network server instead of LocalServer, download and install
SchemaAgent Server.

To install SchemaAgent Client (the Altova product SchemaAgent™ 2006):
1. Download the SchemaAgent 2006 installation package from the SchemaAgent

download page at the Altova website. If you have purchased Altova's Enterprise XML
Suite or Professional XML Suite, the SchemaAgent 2006 product is included in the
package.

2. Double-click the installer file to run the installation process. Note that a local
SchemaAgent server (called LocalServer in this document) will be installed as part of
the SchemaAgent Client installation process. During the installation process, you will be
asked whether you wish to use SchemaAgent locally (that is via the LocalServer) or via
SchemaAgent Server. Your selection determines the default setting for which server the
client will connect to on startup. This can always be changed using the Extras |
Connect to Server command.  

3. Enter and save the licensing information to activate the product license. The
SchemaAgent Client license must be purchased at the Altova Shop at the Altova
Website. If you have purchased Altova's Enterprise XML Suite or Professional XML
Suite, the license for SchemaAgent Client is included in that package.

Starting SchemaAgent Client and Connecting to the Local Server
In this tutorial, we will work with the local server that is automatically installed with SchemaAgent
Client. You must connect SchemaAgent Client to the local server before you can use it to create
relationships between XML schemas.

To start SchemaAgent Client and connect to the local server:

1. Click the SchemaAgent Client  icon on the Quick Launch toolbar to start
SchemaAgent Client. The Connect to SchemaAgent Server dialog appears.

2. Select Work locally.
3. Click OK to confirm.

Configuring a Path to the Examples Folder
In order to work with SchemaAgent, you must configure at least one path to a folder. Paths you

http://www.altova.com/download_schemaagent.html
http://www.altova.com/download_schemaagent.html
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configure are stored on the SchemaAgent server (in this case, the LocalServer). Using
SchemaAgent Client, you create relationships between existing schemas in these paths. You
can also create new skeleton XML schemas, which can be completed later using XMLSpy.

Because the paths are stored on a server, you can always see the current version of XML
schemas you have edited using SchemaAgent Client in XMLSpy. If you edit a schema file using
SchemaAgent Client and XMLSpy is currently connected to the SchemaAgent server, XMLSpy
prompts you to reload the schema file, if you currently have that file open. 

We will configure a path to the folder that contains the files that are used in this tutorial.

To configure a search path to the SchemaAgent2006\SchemaAgentExamples\Tutorial folder:
1. In the Explorer Pane of SchemaAgent Client, click the Configure Paths tab.

2. Right-click in the Explorer Pane. A context menu appears.
3. Select Add search path. The Add/Edit search path dialog opens.
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4. In the Browse pane, navigate to the install folder for SchemaAgent Client. Select the
SchemaAgentExamples\Tutorial folder in that folder.

5. Click OK.
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4.3 Tutorial Example

The example in this tutorial shows you how to create include, import, and redefine relationships
between example XML schemas, as well as how to view MapForce files.

The example is structured as follows:
· In the first part, you use SchemaAgent Client to create relationships between XML

schemas. You create include, redefine, and import relationships.
· In the second part, you use XMLSpy to redefine an element, and to use redefined,

included and imported elements as types in an XML schema.
· In the third part, you create an include relationship between two schemas using

XMLSpy.
· In the fourth part, you view the relationships that you created between the XML

schemas.
· In the last part, you view a MapForce file.



20 SchemaAgent Tutorial Tutorial Example

© 2006 Altova GmbHAltova SchemaAgent User Manual

4.3.1 Creating Relationships Between XML Schemas

In this section, you will use SchemaAgent Client to create include, redefine, and import
relationships between schemas.

The include/redefine example uses the following schemas:
· event_registration.xsd: This schema is structured to contain information about a

participant who registers for a sporting event. Because these events have fees, a type
for containing credit card information is also defined in this schema.

· dvd_order.xsd: This schema is structured to contain order details for mail order
DVDs, and customer shipping details. In the course of this example, it will include types
from event_registration.xsd, specifically those that store customer and credit
card data.

· book_order.xsd: This schema is structured to contain order details for mail order
books. In the course of this example, it will include and redefine types from 
event_registration.xsd, specifically the types for storing customer and credit
card data.

The import example uses the following schemas, which have different namespaces:
· book_store.xsd: This schema is structured to contain the address of the book store,

and details for each book in the inventory. A type from this  schema will be imported to 
library.xsd.

· library.xsd: This schema is structured to contain the address of the library, and
details (card catalog number and whether the book is currently being borrowed) for
each book in the library. A type containing other book information will be imported to
this schema from book_store.xsd.

The second include example uses the following schemas:
· company1.xsd: This schema is structured to contain information about a company

and its employees. 
· company2.xsd: This schema is structured to contain information about the products of

a company. In the example, the address and employee components from company1.
xsd will be included in this file.

Creating an Include Relationship

In this step we will create an include relationship that includes the schema 
event_registration.xsd in the schema dvd_order.xsd.

Do the following in SchemaAgent Client:
1. Select File | New.  A new Design tab appears. 
2. Drag and drop the event_registration.xsd and dvd_order.xsd schemas from

the SchemaAgent2006\SchemaAgentExamples\Tutorial\include_redefine folder in the
Explorer pane to the Design tab.

Please note: To drag and drop more than one file at the same time, select the files first
by clicking on the files while holding down the CTRL key. Drag and drop a folder to put
all the files it contains in the Design tab.
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3. Click on the small white triangle on the right side of the file box of
event_registration.xsd.

4. Drag the connector line to the file box of dvd_order.xsd. Release the mouse over
the word "includes". 

A green arrow that points from event_registration.xsd to dvd_order.xsd
appears. This arrow shows that an include relationship has been made between these
schemas.

Position the cursor over the arrow to display a Quickinfo bubble that contains
information about the relationship.
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You can also position the cursor over a file box to display a Quickinfo bubble that
contains information about the imports, includes and redefines associated with the
corresponding schema.

Creating a Redefine Relationship

We will now create a redefine relationship that allows redefinition of components from the
schema event_registration.xsd in the schema book_order.xsd.

Redefinition of schemas works as follows:
· it creates an implicit "include" relationship between the schemas and enables access to

all elements in the referenced schema
· it allows you to redefine (i.e., restrict or extend) zero or more components of the

referenced schema

Please note: In SchemaAgent Client, only the redefine relationship is created between the
schemas. The actual redefinition of individual components can be done in XMLSpy.

Do the following in SchemaAgent Client:
1. Drag and drop the file book_order.xsd from the Explorer pane to the new Design

tab.

2. In the Design tab, click on the small triangle on the right side of the file box of 
event_registration.xsd.

3. Drag the connector line to the file box of book_order.xsd. Release the mouse over
the word "redefines". 
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A purple arrow that points from event_registration.xsd to book_order.xsd
appears. This arrow shows that a redefine relationship has now been made between
these schemas.

Creating an Import Relationship

In this step we will create an import relationship between the schemas book_store.xsd and
library.xsd. The import relationship is used when you want to reuse components from one
schema in a schema with a different namespace.

Do the following in SchemaAgent Client:
1. Select File | New.  A new Design tab appears.
2. Drag and drop the files book_store.xsd and library.xsd from SchemaAgent2006

\SchemaAgentExamples\Tutorial\import to the new Design tab.

3. Click on the small white triangle on the right side of the file box of book_store.xsd.
4. Drag the connector line to the file library.xsd. Release the mouse over the word

"imports".
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A blue arrow that points from book_store.xsd to library.xsd appears. This arrow
shows that an import relationship has been made between these schemas.



© 2006 Altova GmbH

Tutorial Example 25SchemaAgent Tutorial

Altova SchemaAgent User Manual

4.3.2 Using XMLSpy as a SchemaAgent Client

You have now created include, import and redefine relationships between schemas using 
SchemaAgent Client. When you create a relationship using SchemaAgent Client, the
corresponding include, import or redefine statement is automatically added to the XML schema.

The next step in this tutorial is to use XMLSpy to do the actual including, importing and
redefining of individual components of the schemas. 

In this section, we will do the following:
· include a type from one schema in another schema
· redefine a type and use it as the type of an element in the redefining schema
· import a type from one schema to a schema with a different namespace

Including a Type

Using XMLSpy as a client to the SchemaAgent local server, we will include types from
event_registration.xsd in dvd_order.xsd. We will include a type for storing
information about a customer making a DVD order, and a type for storing credit card
information. 

To do this, we first have to make the types we want to include in dvd_order.xsd into global
complex types.

To make the components personInfo and creditCardInfo into global complex types:
1. Open the schema event_registration.xsd in XMLSpy. To do this, from

SchemaAgent Client, right-click on the file box of event_registration.xsd and
select Edit in XMLSpy from the context menu. The file is opened in XMLSpy. 

2. Connect XMLSpy to the SchemaAgent local server:
a. Select Schema design | Connect to SchemaAgent Server. The Connect to

SchemaAgent Server dialog appears.
b. Select Work locally and click OK. XMLSpy is now connected to the SchemaAgent

local server.

3. Click on the Display Diagram  icon for the element event_registration to display its
content model.

4. Right-click on the personInfo element and select Make Global | Complex type from
the context menu. There is now a global complex type called personInfoType.

Please note: If "type" does not appear as shown in the screenshot, select Schema
design | Configure view. In the Schema display configuration dialog, click the
Predefined button, then click OK to confirm.
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5. In the same way, make the creditCardInfo element into a global complex type. This
results in a type called creditCardInfoType.

6. Save the file.

To include personInfoType and creditCardInfoType in dvd_order.xsd:
1. Open the schema dvd_order.xsd in XMLSpy. Notice that the schema contains an

include statement, which was automatically added when you connected the two
schemas in the Include section discussed previously.

2. Click on the Display Diagram  icon for dvd_order.

3. Right-click on the sequence element and select Add child | Element. Enter the name
customerInfo for this element.

4. With this element still selected, in the Details entry helper, select personInfoType from
the type drop-down list. Components from both schemas are in black, all others are in
blue.



© 2006 Altova GmbH

Tutorial Example 27SchemaAgent Tutorial

Altova SchemaAgent User Manual

5. Right-click on the sequence element and select Add child | Element. Enter the name
creditCardInfo for this element.

6. With this element still selected, in the Details entry helper, select creditCardInfoType
from the type drop-down list.

7. Save the file.

We have now included two types from the schema event_registration.xsd in the
schema dvd_order.xsd.

Redefining a Type

We will redefine the type personInfoType from the schema event_registration.xsd in the
schema book_order.xsd. We will add a customer number to personInfoType.

To redefine this type:
1. Open the book_order.xsd schema in XMLSpy. Notice that the schema contains a

redefine statement, which was automatically added when you connected the two
schemas in the Redefine section discussed previously.

2. Select the line that says "end of redefine". Click the Insert  icon and select
ComplexType. Enter the name personInfoType for this type.
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3. Click the Display Diagram  icon for personInfoType. The content model of
personInfoType, as defined in event_registration.xsd, appears.

4. Right-click the  complexType, and select Insert | Sequence.

5. Right-click on the new sequence icon and select Add Child | Element.
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6. Type in the name customerNumber for the element. 

7. In the Details entry helper, select xs:string from the type drop-down list.

8. Save the file.

We have now redefined personInfoType to be used as a type in the XML schema 
book_order.xsd.
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Using a Redefined Type

To use the type that you redefined in the last step as a type in the book_order.xsd schema:
1. Click the schema overview icon for book_order.xsd.

2. Click the Display Diagram  icon of the root element book_order.

3. Right-click on the sequence element and select Add child | Element. Enter the name
customerInfo for this element.
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4. Make sure the customerInfo element is still selected and select the type
personInfoType from the type drop-down list in the Details entry helper. Components
from both schemas are in black, all others are in blue.

The redefined type is now being used as the type of an element in book_order.xsd.

Lastly, we will use another type from event_registration.xsd in book_order.xsd
without redefining the type:

1. Right-click on the sequence element and select Add child | Element from the context
menu. Enter the name creditCardInfo for this element.
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2. Make sure the creditCardInfo element is still selected and select the type
creditCardInfoType from the type drop-down list in the Details entry helper. 

3. Save the file.

The type creditCardInfoType is now being used as the type of an element in book_order.xsd.

Importing a Type

We will now import a type that stores information about books from book_store.xsd to
library.xsd. 

The schema book_store.xsd has a different namespace from the schema library.xsd.
Therefore, to use elements from book_store.xsd in library.xsd, these elements must be
imported.

The import relationship has already been created using SchemaAgent Client, so here we will
use a type from the imported schema in the importing schema.

To make the component book into a global complex type:
1. Open the book_store.xsd schema in XMLSpy.

2. Click on the Display Diagram  icon of the book_store element to show its content
model.



© 2006 Altova GmbH

Tutorial Example 33SchemaAgent Tutorial

Altova SchemaAgent User Manual

3. Click on the "+" icon to expand the bookInfo element.

4. Right-click on the book element and select Make Global | Complex type. Click on the
"+" icon to expand the book element. The schema book_store.xsd now includes the
global type bookType.

5. Save the file.

To import bookType to library.xsd:
1. Open the library.xsd schema in XMLSpy. Notice that the schema contains an

import statement, which was automatically added when you connected the two
schemas in the Import section discussed previously.

2. Click on the Display Diagram  icon of the library element to show its content model.
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3. Click on the "+" icon to expand the bookInfo element.

4. Right-click on the sequence icon after the bookInfo element and select Add child |
element. Enter the name bookDetails for the element.

5. With the bookDetails element still selected, in the Details entry helper, select the type
ns2:bookType from the type drop-down list. The element now has "ns2:bookType" as
its type.

6. Save and close all files that are currently open in XMLSpy.

We have now imported a type from the schema book_store.xsd to the schema library.
xsd.
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Including a Type Using Only XMLSpy

This section shows how to include types from one schema in another using only XMLSpy as a
client connected to the SchemaAgent local server.

We will include the types addressType and employeeDataType from the schema company1.
xsd in the schema company2.xsd.

To make the address and the employeeData components in company1.xsd into global
complex types:

1. Open the schema SchemaAgent2006\SchemaAgentExamples\Tutorial
\include2\company1.xsd in XMLSpy. 

2. Click on the Display Diagram  icon for the element company1 to display its content
model.

3. Right-click on the address element and select Make Global | Complex type from the
context menu. There is now a global complex type called addressType.
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4. Click the "+" icon to expand the employees element. Now the employeeData element is
visible.

5. Make the employeeData element into a global complex type. This results in a type
called employeeDataType.

6. Save the file.

To include the global complex types in the schema company2.xsd:
1. Open the schema company2.xsd in XMLSpy. 

2. Click on the Display Diagram  icon for the element company2 to display its content
model.

3. Right-click on the sequence element and select Add child | Element. Enter the name
companyAddress for this element.
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4. Make sure the companyAddress element is still selected and select the type
addressType from the type drop-down list in the Details entry helper. The word
"addressType" is in blue because there is no include, import or redefine relationship
between the schemas.

5. A dialog opens where you can select which type of relationship you want to have
between the two schemas. Select Include and confirm with OK. This inserts an include
statement into the company2.xsd schema.

6. Create a further element with the name employee and type employeeDataType. Notice
that when you select employeeDataType in the type drop-down list, it is in black,
because there is now an include relationship between the schemas.
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7. Save the file.

We have now included two types from the schema company1.xsd in the schema company2.
xsd.

Click the schema overview icon to see the include statement that has been inserted into the 
company2.xsd schema.



© 2006 Altova GmbH

Tutorial Example 39SchemaAgent Tutorial

Altova SchemaAgent User Manual

4.3.3 Viewing the Updated Relationships

In this section, you will use SchemaAgent Client to view the include and redefine relationships
that you created between schemas in the course of this tutorial. 

Do the following:
1. In SchemaAgent Client, make the Design tab active that contains the files

event_registration.xsd, dvd_order.xsd and book_order.xsd.

2. Click the arrow icon  in each of the file boxes to expand it. 

3. Click the "globals" arrow icon  in each of the file boxes.
4. In event_registration.xsd, expand "complexType".
5. In dvd_order.xsd, click "element" and continue to expand its subelements until you

see "customerInfo" and "creditCardInfo".
6. In book_order.xsd, expand "redefines" and continue to expand its subelements until

you see "personInfoType".

Now you can see exactly what elements were included or redefined in other schemas.
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4.3.4 Viewing MapForce (MFD) Files

SchemaAgent Client allows you to view the components of MapForce files.

To view a MapForce file:
1. In SchemaAgent Client, select File | New.  A new Design tab appears. 
2. Drag and drop the files ExpenseLimit.mfd, HasMarketingExpenses.mfd,

MarketingAndDailyExpenses.mfd and MarketingExpenses.mfd from
SchemaAgent2006\SchemaAgentExamples\Tutorial\MapForce to the new Design tab.

3. Right-click on the files and select Insert | All directly referenced files from the context
menu. The related XML schemas and their relationships appear in the Design tab.

4. Click the arrow icon  to expand the file box of each of the MFD files.

Now you can see the MapForce design files and their related XML schemas. Position the cursor
over the title bar of a MapForce file box to get a Quickinfo bubble that displays information
about that file.
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5 SchemaAgent Server

SchemaAgent Server maintains an internal map of relationships between schemas and Altova
MapForce Design (MFD) files within a given folder (including, optionally, sub-folders in that
folder), and serves these schemas and MFD files, together with their inter-relationships, to 
SchemaAgent clients. The relationships between schemas can be modified using
SchemaAgent clients, and the modified relationships are propagated through the affected
schemas via SchemaAgent Server. SchemaAgent Server processes client requests to create,
update, or delete schema IIRs (Includes, Imports, and Redefines) and references between
schemas and MFD files, and manages the communication between SchemaAgent Server and
its clients.

Please note: SchemaAgent Server and its clients transfer data using UDP and TCP over port
2799.

Overview
This documentation for SchemaAgent Server is organized into the following sections:

 

· SchemaAgent Server Installation
· Using SchemaAgent Server
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5.1 SchemaAgent Server Installation

Installation Options

It is possible to install SchemaAgent Server in the following ways:

· Install and start SchemaAgent Server as a standalone server: When installed as a
standalone server, SchemaAgent Server can be started from the Start | All Programs
menu or from a desktop icon. The application opens in a GUI, and, when started, an
application icon appears in the system tray. SchemaAgent Server can be configured
(that is, have search paths defined for it) directly in the GUI. This installation is well
suited for installation on a local machine.

· Install SchemaAgent Server as an interactive service: Installing SchemaAgent
Server as an interactive service causes SchemaAgent Server to be started
automatically on every system start. The SchemaAgent Server application icon is
available in the system tray, and the application can be started and stopped using the
system tray icon. SchemaAgent Server can also be started and stopped using
operating system tools (in Windows XP, Administrative Tools | Services). Installing
SchemaAgent Server as an interactive service saves you the task of starting and
stopping the service manually. Clicking the application icon in the system tray enables
you to show/hide the GUI, change the configuration settings, and shutdown 
SchemaAgent Server. This type of installation is best if SchemaAgent Server is to act
as a network server for multiple clients.

· Install SchemaAgent Server as a (non-interactive) service: Installing SchemaAgent
Server as a non-interactive service completely hides it from users. The operating
system starts SchemaAgent Server automatically on every system start. No system tray
icon is available when SchemaAgent Server is installed as a (non-interactive) service.
In order to configure SchemaAgent Server (that is, define search paths), you must first
install SchemaAgent Server as an interactive service, configure it, and then run it as a
non-interactive service. 

Installing SchemaAgent Server

1. Download the SchemaAgent Server installation package free of charge from the
SchemaAgent download page.

2. Double-click on the SchemaAgent Server installer file.
3. Follow the onscreen instructions. During the installation process, you will be given a

choice of whether you wish to install SchemaAgent Server as a standalone server, an
interactive service, or a (non-interactive) service. These options determine the level of
user interactivity required to start SchemaAgent Server on your computer. 

Installing SchemaAgent Server Using the Command Line

The commands listed below are available when calling SchemaAgent Server. The EXE always
returns a return code when run in command-line mode. If an error is encountered using the
install and remove parameters, then the returned error code is identical to the code supplied by
the operating system.

SchemaAgentServer.exe
 

No command line parameters Start as GUI application.

 /install or -install Install as a (non-interactive) service (creates an entry in the
SCM Database*).

 /install:interactive or 
-install:interactive

Install as an interactive service (creates an entry in 
SCM Database*).

http://www.altova.com/download_schemaagent.html
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 /remove or -remove De-installs the service (deletes entry from the
SCM-Database*).

 /quiet or -quiet Suppresses message boxes that appear when an error 
occurs using the Install or Remove commands.

*  The Service Control Manager (SCM) maintains a database of installed services and driver
services, and provides a unified and secure means of controlling them. The database includes
information on how each service or driver service should be started. It also enables system
administrators to customize security requirements for each service and thereby control access
to the service. (Source: MSDN Library)
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5.2 Using SchemaAgent Server

SchemaAgent Server works as follows:
 

· SchemaAgent Server reads information about the schemas or MapForce Design (MFD)
files in a folder you identify (and optionally in that folder's subfolders). This folder is
called the search path in SchemaAgent terminology. SchemaAgent Server determines
the relationships between these schemas and MFD files, and creates an internal map
of these files and their components. You can define multiple search paths. Once
multiple search paths have been defined in SchemaAgent Server, you can administer
the relationships between one or more schemas in the defined search paths from within
the SchemaAgent Client GUI.

· Information about the schemas and MFD files in the search path/s and the relationships
between these files is then served to SchemaAgent clients that connect to
SchemaAgent Server.

· IIR (Include, Import, and Redefine) relationships between schemas can be modified
and schemas and MFD files can be deleted in SchemaAgent clients. These
modifications and deletions are implemented in the actual schemas via SchemaAgent
Server. SchemaAgent Server processes client requests to create, update, or delete
schema IIRs (Includes, Imports, and Redefines) and to manipulate files, and it
manages the communication between SchemaAgent Server and its clients.

You will, therefore, use SchemaAgent Server to do the following:

· Define the search paths that SchemaAgent Server reads and manages. This is
described in Configuring Search Paths. More than one search path can be defined for a
server. All the schemas and MFD files in all the defined search paths then become
available for use in designing IIR relationships in SchemaAgent clients.

· Maintain an overview of schemas and MFD files in the search paths and of the
interaction between SchemaAgent Server and the various SchemaAgent clients that
connect to the server. This overview is available through the various panes of the GUI,
and is described in the SchemaAgent Server GUI section of this documentation.

This is the extent of your interaction with SchemaAgent Server. Creating SchemaAgent Designs
and manipulating schema files is done in the SchemaAgent Client application.

Please note: SchemaAgent clients use the internal map that is created in SchemaAgent Server
. This map is created or updated when: (i) a new search path is created, or (ii) an existing
search path is modified within SchemaAgent Server; or (iii) SchemaAgent Server is started with
search paths already defined. If the contents of a folder are physically modified (for example, if
a schema file is physically deleted from the repository—and not from within a SchemaAgent
client) after SchemaAgent Server has been started, then SchemaAgent Server's internal
schema map is not automatically updated, and SchemaAgent clients will continue to use the
original map. 

This section contains the following:
· how to start, shut down and hide SchemaAgent Server
· how to view and configure search paths
· how to configure file extensions
· how to view connections to SchemaAgent Server
· how to configure SchemaAgent Server
· how to view log information
· how to access online help
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5.2.1 Starting and Shutting Down SchemaAgent Server

This section explains how to do the following:
· start SchemaAgent Server
· shut down SchemaAgent Server
· show/hide SchemaAgent Server

Starting SchemaAgent Server

To start SchemaAgent Server:
· In the Windows Start menu, select Programs | Altova SchemaAgent Server 2006 |

Altova SchemaAgent Server. The SchemaAgent Server GUI appears (see screenshot
)

The GUI is available if you have installed SchemaAgent Server as a standalone server or as an
interactive service. If you have installed and started SchemaAgent Server as a non-interactive
service, no GUI will be available.

Please note: When SchemaAgent Server is running, the SchemaAgent Server application icon

 appears in the system tray at the bottom right of the screen.

 

GUI Layout
The following general layout options are available:
 

· Right-clicking in the Environment pane or Log pane pops up a context menu with
commands that enable you to toggle on and off the display of the Environment and Log
panes.

· The Environment and Log panes can be closed by clicking the Close button at the
top-right of the respective panes.

· Double-clicking the title bar of the Environment and Log panes enables you to dock or
undock these two panes in the application window.
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· When you drag the title bar of a pane, you can position that pane freely anywhere in
your workspace.

· When you drag the title bar of a pane, blue placement arrows appear in the 
SchemaAgent Server application window. Dragging the pane over one of these
placement arrows docks the pane at the location indicated by that placement arrow.
The four outer placement arrows dock the pane along each of the four edges,
respectively. The four inner placement arrows dock the pane relative to the panes
located along the edges.

Shutting Down SchemaAgent Server

To shut down SchemaAgent Server:
 

· Right-click on the SchemaAgent Server application icon  in the system tray and
select Shutdown. If clients are connected to SchemaAgent Server, before shutdown a
prompt opens, displaying the number of currently connected clients and asking if
shutdown should be continued. If you shut down SchemaAgent Server while clients are
still connected, these clients will lose their connection to SchemaAgent Server. This
means that these clients will not be able to process commands that depend on a
connection to SchemaAgent Server (for example, commands such as creating or
modifying an IIR relationship in a SchemaAgent Design).

Showing/Hiding SchemaAgent Server

To toggle showing and hiding of SchemaAgent Server:

· Right-click on the SchemaAgent Server application icon  in the system tray and
select Hide, or double-click the application icon.
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5.2.2 Managing Search Paths

This section explains how to do the following:
· view search paths
· configure search paths

Viewing Search Paths

To view search paths:
· In the Environment Pane, click the Configure Paths tab.

Configure Paths Tab
The Configure Paths tab of the Environment Pane (see screenshot) displays the currently
defined search paths, and the status of the Recursive setting (active/inactive) for each search
path.
 

The screenshot indicates that this SchemaAgent Server currently has two search paths defined
for it (Examples and XMLSpy2005 under the Search Paths entry), both of which have their
Recursive setting enabled. (When the Recursive setting is enabled, sub-folders are also
included in the search path.) 

The File Extensions entry shows the file extensions that SchemaAgent Server recognizes as
XML Schema and MapForce Design (MFD) files.

Subfolders in a search path are shown only if the Recursive option has been selected in the
definition of the search path. Subfolders that contain W3C XML Schemas or Altova MapForce
Design (MFD) files are shown in dark yellow, while subfolders that contain no W3C XML
Schema or MFD file are shown in light yellow (see screenshot). Among files, only W3C XML
Schema files and MFD files are shown in the tree.
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Configuring Search Paths

Search paths are the paths or folders that are scanned for XML Schemas and MapForce
Design (MFD) files. You can configure (add, edit, or delete) search paths.

Search Path considerations
Depending on the installation location of SchemaAgent Server, certain file access and path
restrictions may apply. If you access schemas on a network share, make sure that the 
SchemaAgent Server application has the correct access permissions.

File system support is as listed below:
 

· UNC paths are supported. Note that schema paths can be, or references within
schemas can contain, UNC paths or relative paths.

· WebDAV folders are supported. Location paths can be, or references within schemas
can contain, WebDAV folders or relative paths.

· FTP connections are supported. Files can be directly accessed using FTP.
· Mapped drives are supported. If drive letters are used in search paths, then machines

hosting SchemaAgent clients must have the identical drive letter mapped to the same
shared folder.

· Local drives/directories are not directly supported. Access to local directories or
resources, however, is possible if the local directories are shared to the network and
search paths on SchemaAgent Server are configured to use the network shares.

Adding or Editing Search Paths
To add or edit search paths:

1. In the Configure Paths tab of the Environment Pane, right-click on the Search Paths
entry, or on an entry for any individual search path. This displays the context menu
shown below.
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2. Click either the Add Search Path or Edit Search Path command to open the Add/Edit
Search Path dialog (see screenshot), which you use to browse for and configure
individual search paths.

 

3. Select either the Directory or URL radio button according to whether your search path
is, respectively, a directory or a URL. Continue by following the appropriate procedure
below.

Search Path is a directory
If the search path is a directory (Directory radio button selected), do the following:

 

1. Enter the search path directly in the Path text box. Alternatively, browse for the required
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directory in the Browse pane; the selected directory is entered in the Path text box.
2. Select the Recursive check box if you wish sub-directories of the selected directory to

be searched. If this check box is not selected, no sub-directories will be searched.
3. Select the Relative Path check box to make the search path entry in the Configure

Paths pane relative; leave the check box unchecked to use an absolute path.

Search Path is a URL
If the search path is a URL (URL radio button selected), do the following:

 

1. Enter the server URL in the Server URL text box of the Browse pane.
2. If authorization is required, select the Connect Using a Different User Name check box

(in the Identification pane), and enter the username and password.
3. In the Browse pane, click the Browse button to browse for the required directory; the

selected directory is entered in the Path text box.
4. Select the Recursive check box if you wish sub-directories of the selected directory to

be searched. If this check box is not selected, no sub-directories will be searched.

Deleting Search Paths
To delete a search path:

· In the Environment Pane on the Configure Paths tab, right-click on the path you want to
delete and select Delete search paths.

The configuration file
The set of schemas and MFD files managed by SchemaAgent Server is defined in an XML file
called SchemaAgentServerCfg.xml, which is stored in the SchemaAgent Server application
folder. This file defines the search paths, and what paths or folders are scanned for schema
files. The SchemaAgentServerCfg.xml file looks something like this:

<?xml version="1.0" encoding="UTF-8"?>
<SearchPaths>

<Path recursive="true">s:\schemas-mydir\</Path>
<Path recursive="true">X:\schemas\</Path>
<Path recursive="true">http://test.webdav.org/dav</Path>
<Path recursive="true">\\Server1\Share1\Dir1\Schemadata</Path>
<Path recursive="true">ftp://myftpserver</Path>

</SearchPaths>
 
Note that any number of search paths can be defined, and search paths include paths on a
local machine, network paths (mapped drive letters and UNC paths), as well as folders on
WebDAV servers and FTP access.

After search paths have been defined, SchemaAgent Server retrieves all schemas and MFD
files in individual search paths and builds an internal map of the relationships between the
schemas and MFD files in a search path. It is this mapping of relationships that enables 
SchemaAgent clients to present data about schema and MFD file relationships graphically.
Further, if an IIR or file manipulation change is made in a SchemaAgent client, it is this mapping
that enables the automatic updating of such changes in related files in the search path.

Please note: It is possible to have multiple SchemaAgent Servers running simultaneously in a
network environment; SchemaAgent Clients on the network can be connected to any server on
the network.
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5.2.3 Configuring File Extensions

To add, edit or delete file extensions for XML schema and MFD files:
· Right-click the Schema or MapForce entries, or the individual file extensions, and

select the required command.
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5.2.4 Viewing Connections to SchemaAgent Server

To view connections to SchemaAgent Server:
· In the Environment Pane, click the Clients tab

The Clients tab (see screenshot) displays details about the clients that are currently connected
to SchemaAgent Server. Connections to SchemaAgent Server are initiated by a request from
the client, and must be made from the client.
 

The screenshot shows that two clients, SchemaAgent Client and XMLSpy, are currently
connected to this SchemaAgent Server. The IP addresses of the connected clients are also
listed. The number of requests made by a client is shown in the RQs column, and the time of
the last request made by each client is shown in the LastRQ column.
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5.2.5 Configuring SchemaAgent Server

Configuring the Display of Panes in SchemaAgent Server

· Select View | Toolbars. Select a pane from the submenu. Display of the pane is
toggled or or off.
or

· Right-click inside the Clients tab to display a context menu that enables you to toggle
the display of the Environment and Log panes.

Configuring Logging Options 

· Select Settings | Logging Options. The Logging Options dialog opens (see
screenshot).

Selecting the Log window active check box causes SchemaAgent Server actions to be
displayed in the Log pane. The Log Input option enables/disables the display of incoming
requests. The Log Output option enables/disables the display of outgoing responses. The Log
Internals option enables/disables the display of internal SchemaAgent Server information.

Selecting the Logfile active check box causes SchemaAgent Server actions to be written to a
log file. The log file is a Comma Separated Values (.csv) file called
SchemaAgentServerLog.csv. The log file is created in the same folder as SchemaAgent
Server each time you start a SchemaAgent Server session and if the Log File Active check box
is selected.
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5.2.6 Viewing Log Information

The Log pane (see screenshot) shows client requests, server responses, and other
server-related data. This data is presented as a description, together with the time of execution
(in the case of actions) or the time of data transfer (in the case of notifications). When the
information involves a client, the client is listed together with its IP address. 

Requests from the client are indicated with a blue, right-pointing arrow. Responses from the
server are indicated with a green, left-pointing arrow. The source client (of requests) and target
client (for responses) are indicated in the Source/Target column. The Description column shows
the kind of action, while the Time column gives the time of the action.

Note the following:
 

· Each time a search path is modified in SchemaAgent Server (for example, if the
Recursive option is disabled for a search path), the modified file structure is sent by
SchemaAgent Server to all connected clients.

· If a folder that is in a search path has its structure modified outside SchemaAgent
Server (for example, if a subfolder is deleted from the repository), then this information
is not updated in SchemaAgent Server until search paths are reloaded.

· The Failed to read schema message appears when a schema file includes or
imports other schemas which cannot be found at the location specified.
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5.2.7 Getting Help

Help Menu
The Help menu contains commands that provide access to the onscreen help files, and that are
links to useful resources on the Altova website.

http://www.altova.com/
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6 SchemaAgent Client

SchemaAgent Client Overview
SchemaAgent™ 2006—called SchemaAgent Client in this documentation—enables you to build
a SchemaAgent Design, in which you create or modify IIR relationships (Imports, Includes, and
Redefines) between schemas. 

In a SchemaAgent Design, you can also view relationships between schemas and between a
schema-based MapForce (.mfd) file and its associated schemas. A SchemaAgent Design is
saved as a SchemaAgent Design (.sad) file, which can subsequently be opened in
SchemaAgent Client and edited. SchemaAgent Client has a simple, easy-to-use GUI, in which
schemas can easily be linked to each other using standard GUI techniques, such as
drag-and-drop. Additionally, SchemaAgent Client enables you to manage schemas (rename
them, move them, delete them, etc.) so that references to schemas that have been modified in
this way are globally updated in related files. This functionality makes SchemaAgent Client a
powerful workspace from which to manage large numbers of complex, related schemas, and
edit relationships between these schemas.

How SchemaAgent Client Works
SchemaAgent Client connects to a SchemaAgent server. It can either connect to the
LocalServer that is installed with the SchemaAgent product, or connect to Altova's free
SchemaAgent Server product. The main difference between these two servers is that
LocalServer is installed on the local machine and serves clients on the same computer, while
SchemaAgent Server can be installed on a network machine, serves multiple clients, and
provides detailed logging information.
After connecting to the server, SchemaAgent Client retrieves information about the schemas
and MapForce Design (MFD) files in SchemaAgent Server's search paths, and displays the
folders in the search paths as a tree structure (hierarchical and flat) in SchemaAgent Client. In
SchemaAgent Client, you then drag schemas/MFD files from the tree (in the Explorer pane of
the GUI) and drop them into the SchemaAgent Design in the Design pane. In the Design pane,
you can view the composition of schemas and MFD files, and build relationships between the
schemas in the SchemaAgent Design. When you build or modify a relationship between two
schemas, not only are the actual schema files updated with the new information, but all other
linked schemas affected by the relationship are also updated. Additionally, in the Explorer pane
of SchemaAgent Client (which shows the folders in a tree structure), you can manage schemas
at a high level (rename them, move them, delete them, etc.).
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6.1 Installing and Starting SchemaAgent Client

This section describes how to do the following:
· install SchemaAgent Client
· start and exit SchemaAgent Client

The SchemaAgent Client GUI is also described.
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6.1.1 Installing SchemaAgent Client

To install SchemaAgent Client (the Altova product SchemaAgent™ 2006):
1. Download the SchemaAgent 2006 installation package from the SchemaAgent

download page at the Altova website. If you have purchased Altova's Enterprise XML
Suite or Professional XML Suite, the SchemaAgent 2006 product is included in the
package.

2. Double-click the installer file to run the installation process. Note that a local
SchemaAgent server (called LocalServer in this document) will be installed as part of
the SchemaAgent Client installation process. During the installation process, you will be
asked whether you wish to use SchemaAgent locally (that is via the LocalServer) or via
SchemaAgent Server. Your selection determines the default setting for which server the
client will connect to on startup. This can always be changed using the Extras |
Connect to Server command.  

3. Enter and save the licensing information so as to activate the product license. The
SchemaAgent Client license must be purchased at the Altova Shop at the Altova
Website. If you have purchased Altova's Enterprise XML Suite or Professional XML
Suite, the license for SchemaAgent Client is included in that package.

http://www.altova.com/download_schemaagent.html
http://www.altova.com/download_schemaagent.html
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6.1.2 Starting and Exiting SchemaAgent Client

Starting SchemaAgent Client
After you have successfully installed SchemaAgent Client, the application appears in your
program list (Start | All Programs).

To start SchemaAgent Client:

1. Click the SchemaAgent entry in the All Programs list or the SchemaAgent icon  in
the Quick Launch tray. If your license information has not yet been registered with 
SchemaAgent, you will be prompted for it when you try to start SchemaAgent. If you
have registered a valid license, the following dialog will appear:

 

2. Select Work Locally to connect to LocalServer. Select Connect to Network Server to
select a currently running SchemaAgent Server (on the network) from the drop-down
list.

3. Confirm with OK.

Exiting SchemaAgent Client
To exit SchemaAgent Client:

· Select File | Exit.
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6.1.3 SchemaAgent Client GUI

The SchemaAgent Client GUI has two main areas: the Explorer pane at left, and the Design
pane at right (in which one or more SchemaAgent Designs can be open at a time). In addition,
there is an Overview pane and standard Windows GUI features such as a Menu Bar, Toolbars,
and a Status Bar.

Overview Pane
The Overview pane shows what part of the currently active design is currently in view in the
Design Pane. The red rectangle in the Overview pane represents the current viewport, and it
can be dragged so that another part of the design is brought into view in the Design pane.

Design Pane
The Design pane contains one or more SchemaAgent Design tabs (Design tabs, for short).
Each Design tab graphically displays schemas and MFD files dragged onto the tab from the
Explorer pane and shows existing IIRs (Includes, Imports, Redefines) between these schemas
and between MFD files and schemas with customizable colored lines. You can additionally
create your own IIR relationships between schemas using drag-and-drop. SchemaAgent Design
s created in the Design tab can be saved individually, thus enabling you to manage large groups
or collections of schemas. SchemaAgent Designs can be saved as .sad files, which can
subsequently be re-opened and edited.

In the Design tab, you can do the following:
· create IIR relationships between schemas using drag-and-drop
· correct IIR references
· align and sort schemas in the graphical Design representation
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· delete schemas from the SchemaAgent Design
· recreate ghost schemas
· view schema information

Moving and arranging GUI panes
The Overview and Explorer panes can be docked in the GUI, be made to float, or be hidden. To
do any of these, right-click the title bar of the relevant pane and select the required option.
Double-clicking the title bar of these panes toggles them between the docked and the floating
position.

You can also drag a pane to a desired docking location. When you drag a pane (by its title bar),
two sets of positioning arrows appear. The outer set docks the dragged pane within and relative
to the application window. The inner set docks the dragged pane relative to the pane in which
the inner set of arrows appears. To dock the dragged pane in one of these positions, drag the
pane over one of the positioning arrows and release it.

When a pane is docked over another pane, the panes become tabbed panes and the required
tab can be selected by clicking its tab. To separate two such tabbed panes, drag the tab (not
the title bar) and release it at the required location.

You can resize panes by dragging their borders.
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6.2 Connecting to a Server

In order to use SchemaAgent Client, you must start one of the following servers:

· the local server
· SchemaAgent Server

and connect to it.



© 2006 Altova GmbH

Connecting to a Server 65SchemaAgent Client

Altova SchemaAgent User Manual

6.2.1 Starting and Shutting Down LocalServer

Starting LocalServer
When SchemaAgent Client is started, LocalServer is started automatically.

To start LocalServer automatically when the user logs in (i.e. from the Startup folder):
· Go to Tools | Options | Miscellaneous and select Startup during user login (Add to

Startup folder).

Shutting down LocalServer
To shut down the LocalServer:

· Click the LocalServer's icon  in the system tray (at bottom right of your screen), and
then select Shutdown  SchemaAgent LocalServer.
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6.2.2 Installing and Starting SchemaAgent Server

See SchemaAgent Server Installation.
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6.2.3 Making a Connection

This command can be used to connect to a SchemaAgent server (LocalServer or
SchemaAgent Server) other than that to which SchemaAgent Client is currently connected or to
a SchemaAgent server with which SchemaAgent Client has lost connection. 

1. Select Extras | Connect to server. The Connect to SchemaAgent Server dialog opens.
 

2. Select whether you want to work locally (using LocalServer) or use a network-based
SchemaAgent Server. If a SchemaAgent server connection already exists, you have to
close this connection before making a new connection. 
· Select Work Locally to start and connect to LocalServer.
· Select Connect to network server to connect to a network-based SchemaAgent

Server that is already running.
3. Click OK.

To close a connection:

· Right-click the server's icon  in the system tray (at bottom right of your screen), and
select the Shutdown command. 
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6.3 Managing Search Paths

This section describes how to do the following:
· view search paths
· configure search paths
· reload search paths
· reset search paths

This section also describes the SchemaAgent configuration file.

Search Path considerations
Depending on the installation location of SchemaAgent Client, certain file access and path
restrictions may apply. If you access schemas on a network share, make sure that the 
SchemaAgent Client application has the correct access permissions.

File system support is as follows:
 

· UNC paths are supported. Note that schema paths can be, or references within
schemas can contain, UNC paths or relative paths.

· WebDAV folders are supported. Location paths can be, or references within schemas
can contain, WebDAV folders or relative paths.

· FTP connections are supported. Files can be directly accessed using FTP.
· Mapped drives are supported. If drive letters are used in search paths, then machines

hosting SchemaAgent clients must have the identical drive letter mapped to the same
shared folder.

· Local drives/directories are not directly supported. Access to local directories or
resources, however, is possible if the local directories are shared to the network and
search paths on LocalServer are configured to use the network shares.
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6.3.1 Viewing Search Paths

To view search paths:
· In the Explorer Pane, select the Configure Paths tab. The currently defined search

paths and file extensions are displayed. 

Please note: The Configure Paths tab is available only when SchemaAgent Client is
connected to LocalServer, and not available when SchemaAgent Client is connected to a
network-based SchemaAgent Server.
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6.3.2 Configuring Search Paths

Search paths are the paths or folders that are scanned for XML Schemas and MapForce
Design (MFD) files. You can configure (add, edit, or delete) search paths.

Please note: You can only use this procedure when connecting to the local SchemaAgent
server. If you are using SchemaAgent Server, you must configure paths in that application. See
Configuring Search Paths.

To configure (add, edit, or delete) search paths:
1. In the Explorer Pane on the Configure Paths tab, right-click on the Search Paths entry,

or an entry for any individual search path. A context menu appears (see screenshot).
 

2. Click Add Search Path or Edit Search Path. The Add/Edit search path dialog opens (
see screenshot). You can use this dialog to browse for and configure individual search
paths.
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3. Select either the Directory or URL radio button according to whether your search path
is, respectively, a directory or a URL.

Search Path is a directory
If the search path is a directory (Directory radio button selected), do the following:

 

1. Enter the search path directly in the Path text box. Alternatively, browse for the required
directory in the Browse pane; the selected directory is entered in the Path text box.

2. Select the Recursive check box if you wish sub-directories of the selected directory to
be searched. If this check box is not selected, no sub-directory will be searched.

3. Select the Relative Path check box to make the search path entry in the Configure
Paths pane relative; leave the check box unchecked to use an absolute path.

Search Path is a URL
If the search path is a URL (URL radio button selected), do the following:
 

1. Enter the server URL in the Server URL text box of the Browse pane.
2. If authorization is required, select the Connect Using a Different User Name check box

(in the Identification pane), and enter the username and password.
3. In the Browse pane, click the Browse button to browse for the required directory; the

selected directory is entered in the Path text box.
4. Select the Recursive check box if you wish sub-directories of the selected directory to

be searched. If this check box is not selected, no sub-directory will be searched.
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6.3.3 Reloading Search Paths

This command updates the search paths. It is useful if files have been changed outside 
SchemaAgent Client, for example, in XMLSpy. Also, after a search path or file extension has
been added, edited, or deleted, an asterisk appears at the right of the search path or file
extension. This indicates that the currently loaded search paths need to be updated.

To reload search paths:
· In the Explorer pane on the Configure Paths tab, right-click and select Reload search

paths from the context menu.
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6.3.4 Resetting Search Paths

The Reset Search Paths resets search paths to the original settings with which they were
saved.

To reset search paths:
· In the Explorer pane on the Configure Paths tab, right-click and select Reset search

paths from the context menu.
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6.3.5 Configuration File

The set of schemas and MFD files managed by LocalServer is defined in an XML file called
SchemaAgentServerCfg.xml, which is stored in the SchemaAgent Client application folder.
This file defines the search paths, and what paths or folders are scanned for schema files.
The SchemaAgentServerCfg.xml file looks something like this:

<?xml version="1.0" encoding="UTF-8"?>
<SearchPaths>

<Path recursive="true">s:\schemas-mydir\</Path>
<Path recursive="true">X:\schemas\</Path>
<Path recursive="true">http://test.webdav.org/dav</Path>
<Path recursive="true">\\Server1\Share1\Dir1\Schemadata</Path>
<Path recursive="true">ftp://myftpserver</Path>

</SearchPaths>
 
Note that any number of search paths can be defined, and search paths include paths on a
local machine, network paths (mapped drive letters and UNC paths), as well as folders on
WebDAV servers and FTP access.

After search paths have been defined, LocalServer retrieves all schemas and MFD files in
individual search paths and builds an internal map of the relationships between the schemas
and MFD files in a search path. It is this mapping of relationships that enables SchemaAgent
clients to present data about schema and MFD file relationships graphically. Further, if an IIR or
file manipulation change is made in a SchemaAgent client, it is this mapping that enables the
automatic updating of such changes in related files in the search path.
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6.4 Managing Folders and XML Schemas

The Explorer pane displays all schemas and MapForce Design (MFD) files available in all
search paths defined for the selected SchemaAgent Server.  
In the Hierarchical and Flat tabs, you can create a new schema, MapForce Design (MFD) file,
or folder; rename schemas, MFD files, and folders; delete schemas, MFD files, and folders;
move schemas, MFD files, and folders to other positions under each path entry; and recreate
schemas. 

If an action, such as renaming or deleting, or IIR changes (Includes, Imports, Redefines), that
affects any schema referencing the changed schema
is carried out on a schema or MFD file, all relationships of any schemas referencing the
modified file or folder are immediately and automatically updated, and, in some cases, the
changes are propagated through the search paths. 

Warning: Any change made in the Hierarchical and Flat tabs automatically affects any
schema referencing the changed schema. Since there is no Undo command available for these
actions, it is highly recommended that you have a working backup system or use source control
software when working with SchemaAgent Client.

Hierarchical Tab
The Hierarchical tab shows all the schemas and MFD files in all the search paths defined in
the selected SchemaAgent Server in a tree structure (see screenshot). Folders that contain a
W3C XML Schema or a MFD file are colored yellow. Folders that contain no W3C XML Schema
or MFD file or no subfolder containing a W3C XML Schema or MFD File are grayed out. The
option to show empty folders (accessed in the context menu by right-clicking an entry) can be
toggled off.

In addition to the search paths defined in the selected SchemaAgent Server, the Hierarchical
tab may display a folder called External schemas. The schemas contained in this folder are
schemas which are referenced by schemas in the defined search paths but which are not
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themselves in any of the defined search paths.

Flat Tab
The Flat tab (see screenshot) displays a flat list of all W3C XML Schemas and MFD files in all
search paths defined in the selected SchemaAgent Server, as  well as all schemas in the
External schemas folder (i.e. schemas referenced by schemas in the search paths, but
which are not themselves in any search path), if such schemas exist. Each schema and MFD
file entry is displayed with its location and its status.

In the screenshot, note the different icons used to indicate ghost schemas and schemas with
unresolved relations.
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6.4.1 Creating Folders and XML Schemas

To create a folder or XML schema:
· In the Explorer Pane on the Hierarchical tab, right-click on the folder where you want to

create the file or folder. A submenu appears containing commands to create either a
new schema, new MFD file, or new folder.

When a new schema is created, the following things happen:
 

· A rudimentary schema file called untitled.xsd is physically created in the folder that
currently has the focus in the Hierarchical tab. The file will have an empty schema
declaration, and will look like this:

 

<?xml version="1.0" encoding="UTF-8"?>
<xs:schema elementFormDefault="qualified"
attributeFormDefault="unqualified" 
xmlns:xs="http://www.w3.org/2001/XMLSchema"/>

 

· In the Hierarchical tab, an entry for a schema called untitled.xsd is created in the
folder that currently has the focus in the Hierarchical tab. You can now change the
filename. If you add a different file extension than .xsd, a warning prompt appears. 

When a new MFD file is created, a rudimentary MFD file called untitled.mfd is created in
the selected folder.

When a new folder is created, an empty folder called new folder is physically created in the
folder that currently has the focus in the Hierarchical tab and an entry for this folder is created in
the Hierarchical tab.

Please note: If the Show Empty Folders option is unselected, the new folder, because it
contains no schemas, will not be displayed in the Hierarchical tab.
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6.4.2 Renaming Folders and XML Schemas

To rename a folder or file:
· In the Explorer Pane, right-click on the folder or file and select Rename or press F2.

Change the name as desired. Any references to the changed name in schemas are
automatically updated.
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6.4.3 Deleting Folders and XML Schemas

Deletes the folder or file physically from the hard disk.

Please note: Deleted schemas are not placed in the Windows Recycle Bin, and this step
cannot be undone.

To delete a folder or file:
· In the Explorer Pane, right-click on the folder or file and select Delete.

If the deleted schema is present in a Design tab, then it is represented as an unknown schema
(see screenshot); since the schema is physically deleted, SchemaAgent Server has no more
knowledge of it. SchemaAgent Client, however, still has an entry for it in the Design tab, where it
receives a yellow alert icon.

 



80 SchemaAgent Client Managing Folders and XML Schemas

© 2006 Altova GmbHAltova SchemaAgent User Manual

6.4.4 Configuring File Extensions

To configure file extensions:
· In the Explorer Pane on the Configure Paths tab, right-click a file extension in the File

Extensions tree (click in the Schema or MapForce entry depending on which category
you want to add the file extension to). A context menu appears (see screenshot),
offering options to add a file extension for the selected category, or to edit or delete the
selected file extension.

 

 

If a search path or file extension has been added, edited, or deleted, an asterisk appears at the
right of the search path or file extension. This indicates that the currently loaded search paths
need to be updated.
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6.4.5 Showing Empty Folders

In the Explorer pane, it is possible to turn off the display of folders that contain no XML
schemas.

To toggle on and off the display of folders that contain no schemas:
· In the Explorer pane, right-click on the Hierarchical tab and select Show Empty

Folders. 
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6.4.6 Editing Files in XMLSpy

To edit a document in XMLSpy:
· In the Design Tab or in the Explorer Pane, right-click on the schema you want to edit

and select Edit in XMLSpy or press Ctrl+Y. The selected schema is opened in
XMLSpy if XMLSpy is installed. 
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6.4.7 Displaying Files in MapForce

To show a file in MapForce:
· In the Design Tab, right-click on the MFD file you want to open and select Edit in

MapForce or press Ctrl+M. The select MFD file is opened in MapForce if MapForce
2006 is installed. 
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6.5 Viewing MFD Files, XML Schemas, and their Relationships

This section describes the following:
· how to view MFD file information
· how to view XML schema information, and relationships between schemas
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6.5.1 Viewing MFD Files

To view a MapForce Design (MFD) file:
· Drag and drop the file you want to view from the Explorer pane to a Design pane.

To insert all related underlying files (not just the input and output schema files) in the Design:
· Right-click the MFD file's title bar and select Insert | All linked files from the context

menu.

The following information about MapForce Design files is available in Design tabs (see
screenshot):

 

· The MFD file in the above screenshot (yellow title bar) shows the source schema/s
(Inputs) and target schema (Outputs) of the MFD file. Mapped nodes and their
ancestors in both schemas are shown.

· The relationships between the schemas on which the MFD file is based are displayed
when the required schemas are present in the Design pane. 

To view the mappings between nodes in the input and output schemas, click the MapForce

Design icon  in the column between the Inputs and Outputs panes. The mapping opens up in
a separate MapForce Design pane between the Inputs and Outputs panes (see screenshot).
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You can also view the XSLT file of the MapForce mapping and the XSLT output by clicking the
respective tabs at the bottom of the MapForce Design pane. To close the pane, click the
MapForce Design icon.

Please note: 
· In order for the MapForce Design pane to be displayed, MapForce 2006 must be

installed on your computer.
· You cannot modify a MapForce Design from within SchemaAgent. All modifications of

the MapForce design must be done in MapForce.
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6.5.2 Viewing Schemas and Their Relationships

The following information about schemas is available in Design tabs (see screenshot):

 

· The structure of individual schemas is indicated within the individual schema boxes.
Each schema box has a section each for Includes, Imports, Redefines, and Globals.
Each of these sections contains a detailed sub-structure of that section's components.

· The relationship between two schemas is indicated by solid line connectors leading
from the title bar of a schema box to either the title bar of another schema box when the
schema box is minimized, or to an Include, Import, or Redefine section within a schema
box when the schema box is expanded.
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· The relationship between components in two schemas is indicated by connectors
leading from a global component in one schema box to a global component in another
schema box.

Please note: To display relationships between the components of two schemas, the Globals
sections of both schemas must be expanded.

Schema box and schema structure
Each schema is displayed as a box, which can be expanded and minimized. When schemas
are inserted into a Design, they are inserted as minimized schema boxes. 
 

In the above schema, note that there are two arrowheads. The arrowhead on the left indicates
that this schema either includes, imports, or redefines other schemas or schema components.
You can determine exactly what kind of relationship/s and with which other schemas or schema
components by expanding the schema box (which is explained below). The arrowhead on the
right is used to create an IIR that includes, imports, or redefines this schema or its schema
component/s in other schemas (see Creating Includes, Imports and Redefines for details).

Minimized schema boxes can be expanded (see screenshot) by clicking the button in the title
bar. They expand into four sections: Includes, Imports, Redefines, and Globals. In the
screenshot below, the arrowheads at the left of the Imports and Redefines sections indicate that
this schema imports at least one schema and at least one schema component from an external
schema.
 

Each section of the schema box can be further expanded if a sub-structure is present, and this
sub-structure is displayed as a freely expandable tree structure of IIRs and global components.
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Quick Information
When you mouseover the title bar of a schema box, a Quick-Info Box containing the following
information is displayed:
 

· Location of the schema
· Target namespace
· IIR information about the schema, for example, what schemas are included in, or by,

that schema

Please note:
 

· The Quick-Info Box displays IIR information as determined in the SchemaAgent Server
search path.

· Placing the text cursor over an alert icon , if visible in the schema box, opens the
relevant error message in the Quick-Info Box.
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The display of IIRs in the Design tab
IIRs (Includes, Imports, Redefines) between schemas in a Design tab are graphically displayed
by means of connector lines between schema boxes (see first screenshot in this section). Two
types of connectors exist: (i) those that show IIRs between two schemas, and (ii) those that
show relationships between global components in two schemas. Lines to show relationships
between schemas go from the title bar of one schema box to the Includes, Imports, and/or
Redefines section/s of the second schema box. Lines to show relationships between global
components in two schemas go from the respective component in the Globals section to the
related component in the Globals section of the second schema.

The appearance of the connector lines can be customized in the Relations tab of the Options
dialog (Tools | Options). The default settings show Imports in blue; Includes in green; and
Redefines in purple-violet. When you place the cursor over a connector line, the line is
highlighted (the appearance of highlighted connector lines can also be configured in the 
Relations tab of the Options dialog (Tools | Options)). An arrowhead appears that indicates
the "direction" of the relationship and a Quick Information box with details of the relationship is
displayed. The appearance of a selected line (different from a highlighted line in that you must
click the line to select it, whereas you mouseover a line to highlight it) can also be configured
separately.

If a component or its type is defined in another schema (indicated by the presence of
arrowheads on the left-hand-side of the component), right-clicking that component enables you
to click Show Component Origin (see screenshot). If, when you select this command, the
schema with the definition is already present in the design, selecting this command causes the
connector line to the relevant definition in the "source" schema to be selected, together with the
connector line showing the relation between both schemas (that is, whether it is an Include,
Import, or Redefine). If the schema box containing the definition is not present in the Design, a
message to that effect is displayed and you are asked whether this schema box should be
inserted into the Design (see screenshots below). If it is inserted, the connector line to the
relevant definition is selected, together with the connector line showing the relation between
both schemas.
 

In the screenshot above, the element Address has a complex type of ipo:US-Address. The
color of the complex type text (blue) indicates that this complex type is (according to the default
color scheme) an import. The two arrowheads to the left of the elements Address and
Address_EU indicate that the two complex types are defined in another schema. Clicking the
Show Component Origin command and choosing to insert the schema with the missing
component inserts the schema and highlights the relevant relationships (see screenshot below).
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Conversely, if in the schema box of address.xsd, you right-click the component
ipo:US-Address (a complex type), and select Show Component Usage, then the link to the
Address element in NanonullOrg.xsd will be highlighted.
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6.6 Designing Relationships Between Schemas

SchemaAgent Client enables you to:
 

· Manage schemas at a high level, for example, rename, move, or delete them. 
· Graphically modify the relationships between schemas and components in different

schemas. This is done through SchemaAgent Designs, which are graphical
representations of IIR (Import, Include, and Redefine) relationships between schemas.
When a relationship between two schemas is modified in a SchemaAgent Design, that
modification is immediately effected in the actual physical file as well as
propagated to all schema files that are affected by the modification. So, for
instance, if a.xsd includes b.xsd, and if, in a SchemaAgent Design, you delete the
include relationship between a.xsd and b.xsd, then the include declaration is
immediately deleted from the file a.xsd.

· View the structure of the source and target schemas of a MapForce Design (MFD) file,
and the relationships of these schemas with other schemas.

Please note: You cannot edit XML schemas directly in SchemaAgent Design.
 
This section contains the following information:

· an overview of the Design pane
· how to create and open designs
· how to insert XML schemas and folders into a design
· how to create includes, imports and redefines
· how to select files in a design
· a reference describing all editing commands available for designs
· how to delete files from a design
· how to reload and recreate XML schemas
· how to correct reference paths
· how to save and close design files
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6.6.1 Design Pane Overview

In the Design pane, you can open multiple Design tabs. Each Design tab contains a 
SchemaAgent Design, in which you can graphically design and manage the relationships
between an unlimited number of W3C XML Schemas, and also display the relationships
between MapForce Design (MFD) files and their associated schemas. In this way you can
organize schemas (and MFD files) into collections of related files. A SchemaAgent Design can
be saved as a .sad file for editing at a later time. Any IIR relationship created in a
SchemaAgent Design is immediately propagated to the respective files as soon as the
relationship is created.

The Design tab graphically shows the structure of individual schemas and MFD files, and the
relationships between such files. Existing relationships between schemas, that is IIRs (Includes,
Imports, or Redefines), are represented with colored lines. Additional IIRs can be created in the
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SchemaAgent Design. When you mouseover the title bar of a schema box in the Design pane,
a Quick Info box appears which contains information about the schema's location, its
namespaces, and its IIRs. When you mouseover the title bar of an MFD file box, a Quick Info
box lists the locations of the source and target schemas.

You can resize schema boxes by dragging box borders; expand and minimize schema boxes by
clicking the arrowheads in the title bar of schema boxes; and expand and collapse trees within
schema boxes by clicking the plus and minus symbols to the left of tree entries.

Expanding and collapsing tree items
When you right-click an item in a file box, the context menu that appears (screenshot below)
provides commands to expand or collapse tree levels, and to size file boxes to fit.
 

 

You can expand or collapse all children of the selected item, or expand or collapse the entire
tree in which the selected item is. The Size to Fit command resizes file boxes to show all visible
items without the file box having any scrollbar.

Navigating within the Design tab
Within a Design tab, you can navigate from one schema to the next using the cursor keys (Up,
Down, Left, Right).
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6.6.2 Creating and Opening Designs

Creating a new design
To create a new SchemaAgent Design (.sad) file:

· Select File | New. A new design pane appears.

Opening design files
To open an existing SchemaAgent Design (.sad) file:

1. Select File | Open. The Open dialog appears.
2. Select the desired file and click Open.

Opening recently opened design files
The File menu displays a list of recently opened SchemaAgent Designs. To open one of these
files, click on the file name.
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6.6.3 Inserting XML Schemas and Folders into a Design

Inserting files into a design from the Explorer Pane
To insert XML schemas, MFD files or folders into a design:

· Select the files or folders and drag them using the left mouse button into the desired
design. The files or the files contained in the dragged folders appear in the design.

Inserting related files into a design
For a description of the types of related files that can be inserted, see Related files.

To insert files related to a schema or MFD file:
· Select the file and drag using the right mouse button (right-drag). A context menu (see

screenshot) appears asking whether you wish to insert only the selected file, or folder
files, or whether related files should also be inserted.

Inserting files related to a selection in the Design
To insert files related to a selection:

1. Select one or more files (XML schema or MFD) in a design.
2. Right-click and select the desired item from the context menu. 

Related files
An XML Schema or MapForce Design (MFD) file can have three types of related schemas:

 

· Directly referenced files: These are schemas that are directly referenced with an IIR
statement. For example, if Schema A has an Include statement that references
Schema B, then Schema B is directly referenced by Schema A. An MFD file directly
references two schemas: its source and target schemas.

· Referenced files: These are schemas that are directly as well as indirectly referenced.
For example, if Schema A has an Include statement that references Schema B, and
Schema B has an Include statement that references Schema C, then (i) Schema B
is directly referenced by Schema A, (ii) Schema C is directly referenced by Schema B,
and (iii) Schema C is indirectly referenced by Schema A. In the case of an MFD file, in
addition to the directly referenced source and target schemas, any schema that these
two schemas reference is considered to be referenced by the MFD file.

· Linked files: These are schemas that are directly and indirectly referenced, as well as
schemas that are linked to any of the directly or indirectly referenced schemas in any
way. For example, if we extend our previous example so that Schema Z includes
Schema B, then Schema Z is linked to Schema A (because Schema A includes
Schema B). Further, if a schema which is linked to a file Test, is either the target or
source schema of an MFD file, then that MFD file is considered to be linked to the file 
Test.
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6.6.4 Creating Includes, Imports and Redefines

XML Schemas provide three main methods of modularizing your schemas: Imports, Includes,
and Redefines, which we collectively call IIRs for short. Each of these methods has specific
namespace requirements, which are automatically checked by SchemaAgent when you create
IIRs in SchemaAgent Client. This section describes how you can work with IIRs in
SchemaAgent.

Overview of IIRs
IIRs are used as follows:

 

· Includes are used to incorporate schema components that belong to the same target
namespace or that do not have a target namespace.

· Imports are used when combining schema components that belong to different
namespaces. Using Import defines the schema location, as well as the namespace for
the schema. This allows the document instance to contain both namespaces.

· Redefines are used to combine and modify schema components of the same target
namespace or that do not have a target namespace. Using Redefines allows you to
incorporate external schema definitions and declarations, such as complexTypes, and
change them in the redefining schema. 

Appearance of IIRs
In the Design tab, IIR relationships between schemas are shown, by default, with lines that are
color-coded as follows:

 

· Includes = green
· Imports = blue
· Redefines = purple-violet

When you place the cursor over a connector line, the connector line is highlighted and an
arrowhead appears that indicates the "direction" of the relationship; the appearance of a
highlighted connector line can be customized in the Connectors tab of the Options dialog (
Tools | Options). When you click on a connector line, the connector line is selected; the
appearance of a selected connector line can also be customized in the Connectors tab of the
Options dialog (Tools | Options). 
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In the above screenshot, address.xsd is included in ipo.xsd and imported into
NanonullOrg.xsd., while budget.xsd is redefined in NanonullOrg.xsd. The Imports
connector line between address.xsd and NanonullOrg.xsd is selected (by clicking it) and
the appearance it has is the default setting for a selected Import connector line. The Redefines
connector line between budget.xsd and NanonullOrg.xsd is highlighted (by placing the
cursor over it), and the arrowhead indicates that budget.xsd is redefined in
NanonullOrg.xsd.

Please note: Connectors appear as soon as a schema is inserted into the Design if the
inserted schema has existing IIR relationships with other schemas present in the Design.

Creating IIRs in the Design Tab
You can create IIRs between schemas in the Design using drag-and-drop.

To create an IIR:
 

1. Place the mouse cursor over the schema box handle (located at the right border of the
title bar) of the schema from which you wish to create the IIR. For the purpose of this
description, let's call this schema the source schema. 

 

 2. Click the handle and drag the cursor to the schema in which the IIR statement is to
appear (the target schema for our purposes). If minimized, the target schema box
expands, allowing you to drop the connector onto one of the IIR entries.
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3. When the selected IIR entry becomes bold, drop the connector. The IIR command has
now been inserted in the schema, and a drop-down symbol appears next to the IIR
entry (in this case, includes).

 

 

Clicking the drop-down arrow expands the IIR entry (in this case, includes).
 

 

If you drop the connector on an entry that does not turn bold, an error message
appears, explaining why the selected IIR relationship is not allowed.

4. You can create additional IIR relationships that are allowed between schemas. So after
including address.xsd in ipo.xsd, you could import address.xsd into
NanonullOrg.xsd and redefine budget.xsd in NanonullOrg.xsd (screenshot
below).
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Please note: SchemaAgent automatically checks namespaces. This ensures that no invalid IIR
statement is created in the target schema.
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6.6.5 Selecting Files in a Design

In a Design tab one or more schemas or MFD files can be selected at a time. However, only
one of the selected files has the focus. It is important to set the focus correctly for some actions,
such as aligning, because the selected files are aligned on the file that has the focus. For other
actions, such as sorting, the focus is irrelevant. In the description below, the selection
mechanism is explained with reference to schemas; note that the same mechanism also
applies to MFD files.

Selecting a single schema
To select a schema in a Design tab, click anywhere inside the schema box. The title bar of the
selected schema becomes a darker blue (default setting; appearances can be configured in the 
Colors tab of the Options dialog (Tools | Options)).
 

 

Since a single schema is selected, this schema also has the focus, which is indicated by the title
being displayed in yellow (default setting).

Selecting multiple schemas
To select multiple schemas in a Design tab, do one of the following:

 

· Click the schema boxes of the schemas you wish to select while keeping the Ctrl key
pressed.

· Use the marquee selection technique on the schema boxes of the schemas you wish to
select (that is, click and drag the marquee rectangle around the required schema
boxes).

The title bars of the selected schema boxes will become a darker blue (default setting; see
screenshot).
 

If you use the Ctrl+click method to select multiple schemas, the last schema to be selected will
receive the focus. If you use the marquee selection method, the last schema box over which the
cursor passes will receive the focus. (If you drag the marquee in such a way that the cursor
passes over no schema box, then no schema will receive the focus.)
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Changing the focus
To change the focus in a selection of multiple schemas, press Ctrl and click twice on the
schema box of the schema to which you want to give the focus.

Selecting with paths
Schema boxes are also selected when the Show Component Origin, Show Component Usage,
and Show Relation Path commands are used.

Copying and pasting a selection
Selections can be copied and pasted across designs. When used with paths, this is a
convenient way to create new designs containing closely related schemas.
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6.6.6 Editing Designs: Reference

Align
The Align commands are layout commands that enable selected file boxes to be aligned
according to a variety of criteria. For a detailed description, see  Customizing the Layout of the
Design.

Copy (Ctrl+C)
Please note: You can copy files from one Design tab to another.

To copy the selected schema or MFD file to the clipboard:
· In a Design tab, select a file and press Ctrl+C.

Correct reference paths (Ctrl+I)
When an IIR statement in a schema or a schema reference in an MFD file points to a file that
cannot be found at the specified location, this command causes SchemaAgent to look for a file
with a name matching that of the referenced file at other locations in the search path. If it finds
one or more matches, a message box opens asking whether the IIR path should be corrected,
and, in the case of multiple matches, which of the matches should be used. If no match is
found, this is reported.

To correct reference paths:
· In a Design tab, right-click on a file and select Correct reference paths.

Cut (Shift+Delete)
To cut the selected schema or MFD file to the clipboard:

· In a Design tab, select a file and press Shift+Delete.

Delete (Delete key)
To delete a file from a design:

· In a Design tab, select a file and press the Delete key.

Drag-and-drop
To move a file within a Design tab:

· Drag and drop the file.

To copy a file to another Design tab:
· Drag the file from the first Design tab to the other Design tab.

Insert
To insert schemas or MFD files that are related to selected schemas or MFD files:

1. In a Design tab, select one or more schemas or MFD files.
2. Right-click anywhere in the Design tab and select Insert. A submenu appears. Select

how you want the inserted files to be related.

These relationships and the use of the Insert command are described in more detail in Inserting
XML Schemas and Folders into a Design.

Please note: Related files are inserted only in the active Design tab.
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Paste (Ctrl+V)
To paste from the clipboard to the selected Design tab:

· In a Design tab, select a file and press Ctrl+V.

Recreate
A schema may contain an IIR statement (that is, an Import, Include, or Redefine declaration)
that references a schema which cannot be found at the location specified in the IIR statement.
We call such a schema a ghost schema. This command recreates a rudimentary schema of
the same name as the ghost schema at the location specified for it in the IIR statement. A
rudimentary schema is one that contains only the xs:schema declaration.

To recreate a ghost schema:
· In a Design tab, right-click on a ghost schema and select Recreate.

Reload
To reload a file:

· In a Design tab, right-click on the file and select Reload.

Select
To select schemas or MFD files that are related to the schemas or MFD files that are already
selected:

1. In a Design tab, select one or more schemas or MFD files.
2. Right-click anywhere in the Design tab and select Select. A submenu appears. Select

how you want the selected files to be related.

These relationships and the use of the Select command are described in more detail in 
Inserting XML Schemas and Folders into a Design.

Please note: Related files are selected only in the active Design tab.

Sort
The Sort commands are layout commands that enable selected file boxes to be sorted
according to a variety of criteria, including alphabetically. For a detailed description, see 
Customizing the Layout of the Design.

Synchronize Selection
This command is most useful when a Design tab is active because it is not possible to rename,
delete, or move a file in a design tab. So, if you synchronize the selection in the Design tab, then
the currently selected file in the Design tab is also selected in the Hierarchical and Flat tabs of
the Explorer pane, enabling you to switch to the Explorer pane and take the required action.

To synchronize a selection:
· Double-click on a file in the Hierarchical tab or the Flat tab of the Explorer pane, or in a

Design tab. The file is then selected in the other two tabs as well. 

Please note: Synchronized selection only applies to the currently selected Design tab and not
to all open Design tabs.
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6.6.7 Deleting Files from a Design

To delete an XML schema or MapForce Design (MFD) file from a design:
· Right-click on a file in a Design tab. Select Delete from the context menu. The file is

removed from the design.

Unknown files
If a file (schema or MFD file) that is deleted from the Explorer pane is present in a Design, then
that file in the Design becomes an unknown file (because SchemaAgent Server no longer has
any knowledge about a file with that name in any of its search paths). Such a file is represented
in Design tabs with a yellow exclamation mark (screenshot below).

The only way to bring a deleted file back into use (thus making the yellow exclamation mark
disappear) is to have the file physically re-created or copied from a backup to its correct
location.

Incorrect references and ghost schemas:
If a schema or MFD file contains a reference to a schema that cannot be found at the specified
location, an error icon appears  in the top left of its title bar (screenshot below). The schema
that cannot be found at the specified location is called a ghost schema (screenshot below). In
the screenshot below, ipo.xsd has an include statement that points to the schema
address.xsd, which cannot be located at the location specified in the Import statement. In this

case, address.xsd is the ghost schema file and is indicated by the icon . All files that
reference address.xsd in an IIR statement are marked with the  error icon, both in their
schema boxes as well as in the Explorer pane.

A schema can be a ghost schema for any of several reasons. The most common are:
 

· The schema is not physically present at the specified location for any of several
reasons. For example, it might have been moved.
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· The schema cannot be loaded because the web server or network node is unavailable.

Note that ghost schemas are displayed in the Explorer and Design panes (even though they are
not at the location specified in the reference). In the Design, the connector line between the
ghost schema and its target schema is also displayed.

If you encounter incorrect references and ghost schemas, there are two possible ways to deal
with the problem:

 

· SchemaAgent Client offers the Correct reference paths command when you
right-click the file with the incorrect reference. This action causes SchemaAgent Client
to look for schemas of the same name in the search path. This is the ideal solution if
the ghost schema has been moved to another location within the search path. In such
cases, SchemaAgent Client lists all the schemas with the ghost schema's name that it
finds in the search paths. You can then select the correct path, and this path will be
inserted as the reference to the schema.

· From within SchemaAgent Client, you can recreate the ghost schema as a rudimentary
schema at the location specified in the reference. You can do this by right-clicking the
ghost schema, and selecting Recreate from the context menu that appears. (Note that
if the folder specified at the location specified in the reference statement does not exist
or is not within the search path, then the Recreate command is not available.) This
solution ensures that the IIR path correctly points to the specified schema. However,
you still have to add appropriate content to the recreated rudimentary schema.
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6.6.8 Reloading XML Schemas

If a schema is edited in an XML editor program (for example, XMLSpy), the changes are not
automatically reflected in SchemaAgent Client. In order to view the structure of the modified
schema in SchemaAgent Client, you have to reload the schema in SchemaAgent Client. 

To reload a schema:
· Right-click the required folder or file in the Explorer pane and select Reload.
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6.6.9 Recreating XML Schemas

A schema may contain an IIR statement that references a schema which cannot be found at the
location specified in the IIR statement. We call such a schema a ghost schema.

To recreate a schema:

· In the Explorer Pane, right-click a ghost schema and select Recreate. This creates a
rudimentary schema of the same name at the location specified for it in the IIR
statement. (A rudimentary schema is one that contains only the xs:schema
declaration.) If the folder specified at that location does not exist or is not within the
search path, then the Recreate command is disabled. 
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6.6.10 Correcting Reference Paths

When a reference in a file (that is, either an IIR statement in a schema or a schema
specification in an MFD file) points to a file that cannot be found at the location specified, you
can use the Correct reference paths command to make SchemaAgent look for a file with a
name matching that of the referenced file at other locations in the search path. If it finds one or
more matches, a message box appears asking whether the IIR path should be corrected, and,
in the case of multiple matches, which of the matches should be used. If no match is found, this
is reported.

Correcting one reference path
To correct a reference path:

· In the Explorer Pane or in the Design Tab, right-click on a file and select Correct
reference paths or press Ctrl + I. 

Correcting all reference paths
To correct all reference paths:

1. Select Extras | Correct all reference paths. The following dialog opens.
 

2. Click Start. If one match is found, you will be prompted to confirm the correction. If
more than one match is found, you will be prompted to select the correct path from a
list of schemas (see screenshot).
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3. To confirm a correction, select an entry and click Yes. The correction is made. Clicking
Skip does not make the correction. If there is more than one incorrect reference, a new
Correct Reference Path dialog will pop up for each incorrect reference.
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6.6.11 Saving and Closing Design Files

Saving a SchemaAgent Design
A SchemaAgent Design can be saved as a SchemaAgent Design (.sad) file. This is useful if
you wish to modify relationships in the SchemaAgent Design at a later time. Note that a set of
schemas (and, therefore, their relationships) can be contained in multiple SchemaAgent Design
s.

To save a design file:
1. Select the design pane for the design file you want to save.
2. Select File | Save. The design is saved in a .sad file.

Saving a copy of a SchemaAgent Design file (Save As)
To save a copy of a file:

1. Select the design you want to save a copy of.
2. Select File | Save As. The Save As dialog opens. SchemaAgent Design (.sad) file.
3. Select the location where the copied file should be saved.
4. Change the file name, if desired.
5. Click Save. The original file is closed and the new copy of the file is opened in a design

pane.

Closing design files
To close the currently active SchemaAgent Design (.sad) file.

1. Select the SchemaAgent design pane for the .sad file you want to close.
2. Select File | Close.
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6.7 Customizing, Exporting and Printing Designs

This section describes the following:
· how to customize the layout of a Design tab
· how to export design files as images
· how to print design files
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6.7.1 Customizing the Layout of the Design

This section explains how to customize the layout and viewing options of the SchemaAgent
Design document.

To use most of these layout commands, you must first select one or more file boxes. See 
Selecting Files in a Design.

Note on selection and focus: To use the alignment and layout features of SchemaAgent
Client, it is important to understand the difference between selecting a file box and giving a
(selected) file box the focus. In the screenshot below, AddressFirst.xsd and
AddressLast.xsd are selected (indicated by deep blue background of title bar).
AddressLast.xsd has the focus (indicated by yellow color of title bar text).
 

File boxes can be selected and given the focus in two ways:
 

· By drawing a marquee around the boxes to select. The last box over which the mouse
cursor passes when drawing the marquee receives the focus; if the mouse cursor does
not pass over any boxes, then no box receives the focus.

· By clicking individual boxes. The clicked box is selected and also has the focus. To
select multiple boxes, press the Ctrl key while clicking a box. The last box to be
selected receives the focus.

Show Grid
To toggle the grid on and off in the SchemaAgent Design document:

· Select Layout | Show Grid.

Align on Grid
This command aligns the top and left edges of schema boxes on the grid.

To align file boxes on the grid:
1. If the grid is not currently displayed, select Layout | Show Grid to display it.
2. Select the file boxes you want to align.
3. Select Layout | Align on Grid.

Zoom
To change the zoom factor:

· Select Layout | Zoom | Zoom. A slider appears that lets you adjust the zoom factor in
the Design Pane.

To make all file boxes fit in the Design Pane:
· Select Layout | Zoom | Zoom to fit. The zoom factor is adjusted so that all file boxes in

the Design Pane become visible.
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To zoom to a selection:

1. Select one or more file boxes.
2. Select Layout | Zoom | Zoom to selection

Layout
The submenu items of this command become enabled when more than one file box is selected.
Layout options are Force Directed and Hierarchical.

Align Edges
To align the edges of file boxes:

1. Select the file boxes you want to align, giving the focus to the file box you want to align
the others with.

2. Select Layout | Align Edges. A submenu appears. Select from this submenu how you
want the edges aligned. 

Line Up
To line up file boxes:

1. Select the file boxes you want to line up.
2. Select Layout | Line Up | Vertically or Horizontally.

When Horizontally is selected, lines up the top edges of the selected file boxes with the top
edge of the file box that has the focus. When Vertically is selected, lines up the left edges of
the selected file boxes with the left edge of the file box that has the focus.

Order
To bring a file box to the top or bottom of a stack of file boxes, if it is part of such a stack:

· Select the file box you want to change the stack position of and select Layout | Order |
Bring to top or Bring to bottom.

Resize
Please note: Resizing height might require that components in a file box be collapsed in order
to attain the height of the file box that has the focus.

To resize file boxes:
1. Select the file boxes you want to resize, giving focus to the file box whose size you want

the others to be changed to.
2. Select Layout | Resize | Make same width or Make same height or Make same size

. 

Space Evenly
To space file boxes evenly:

1. Select three or more file boxes in a design.
2. Select Layout | Space Evenly | Vertically or Horizontally.

Sort
Sorts file boxes in alphabetical order or according to their widths. 

Please note: Alphabetical sorting is case-sensitive.
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To sort files boxes:
1. Select the file boxes you want to sort.
2. Select Layout | Sort | By Name or By Width | Ascending or Descending. 
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6.7.2 Exporting Design Files as Images

To export a design to a PNG image file:
1. Select the design you want to save as an image file.
2. Select File | Export to image. The Save As dialog appears.
3. Select the folder where you want to save the image.
4. Enter the file name for the image.
5. Click Save.
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6.7.3 Printing Design Files

Print
The Design diagram in the active Design tab can be printed together with a header and footer
that provides meta information about the user environment and SchemaAgent application
information.

To print a .sad file:
1. Select the design you want to print.
2. Click File | Print. The Print dialog opens (see screenshot).

 

3. In the Print dialog, select whether the whole diagram or only a selection is printed; what
zoom factor is used; and whether schema boxes are split across page breaks. 

4. Click Print.

Print Preview
To display a preview of a design as it will be printed:

1. Select the design you want to preview.
2. Select File | Print Preview. The Print dialog opens. 
3. Click Preview.

Print Setup
1. Select File | Print Setup. The Print Setup dialog opens.
2. Adjust settings as desired and click OK.
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6.8 Customizing SchemaAgent Client

Several aspects of SchemaAgent Client can be customized. See the following:

· Customizing SchemaAgent Client
· Configuring GUI Appearance
· Configuring the View
· Arranging Windows
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6.8.1 Customizing SchemaAgent Client

In the Customize dialog, you can specify what toolbars should be displayed, set shortcut keys
for menu commands, etc.

To customize SchemaAgent Client:
· Select Tools | Customize. The Customize dialog opens (see screenshot). 
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6.8.2 Configuring GUI Appearance

To configure the appearance of the GUI:
· Select Tools | Options. The Options dialog appears. This dialog allows you to set e.g.,

the general design of the GUI layout, the colors of the schema boxes, the appearance
of IIR connectors, and memory caching.

Most of these options are self-explanatory. The following options may need explanation: 

· In the Design tab, the Threshold Items (in the Move and Resize pane) is the number of
file boxes selected, over which limit, the selected file boxes are shown in outline while
being dragged; if the number of file boxes selected is below the threshold, then the
contents of the boxes are shown while the boxes are being dragged. The Default Insert
Action sets how a schema should be inserted into a design when it is dragged into the
Design Pane (that is, with or without related schemas). The Default Expand Height is
the height of a file box when it is expanded.

· In the Colors tab, you can set colors for components of XML Schema file boxes
separately from those for components of MFD files.

· In the Relations tab, the width and style of lines indicating relationships between
schemas and between schema components can be customized.

· In the Miscellaneous tab, you can set whether LocalServer should be started on user
login and whether it should be shut down when the last client is closed. If data is cached
by a SchemaAgent server, more memory is used, but communication frequency is
lower. You can set whether data should be cached.
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6.8.3 Configuring the View

Toolbars
To switch the display of toolbars on or off:

· Select View | Toolbars. Select the name of the toolbar you want to switch on or off.

The Status Bar
The left-hand side of the Status Bar displays tool tips for commands when commands are
moused over.

To switch the display of the Status Bar on or off:
· Select View | Status bar. 
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6.8.4 Arranging Windows

The Window menu has commands that let you specify how SchemaAgent Design windows
should be displayed in the GUI (cascaded, tiled horizontally, or tiled vertically). 

Additionally, all open windows are listed on this menu, with the active window being checked. To
make another window active, click the name of the window you wish to make active.



© 2006 Altova GmbH

Getting Help 123SchemaAgent Client

Altova SchemaAgent User Manual

6.9 Getting Help

The Help menu provides the following:
 

· access to the Help files (with either Contents, Index, or Search pane active)
· a registration input form
· links to Support sources at the Altova website
· information about SchemaAgent





Chapter 7

XMLSpy and SchemaAgent
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7 XMLSpy and SchemaAgent

Altova's XMLSpy product (Enterprise or Professional edition) can use SchemaAgent technology
to provide powerful schema editing functionality. When XMLSpy has been set up to work with
SchemaAgent, schemas can be directly edited in XMLSpy using components from other
schemas on the network. You can view the content model of a component belonging to another
schema and reuse this component with or without modifications. You can also build
relationships between schemas, thereby enabling you to modularize and manage complex
schemas directly from within XMLSpy.

See also the SchemaAgent Tutorial.

In order for XMLSpy to work as a SchemaAgent client, you must do the following:
 

· Download Altova's SchemaAgent 2006 product from the SchemaAgent download page
at the Altova website and install it on the same machine as XMLSpy. SchemaAgent
Client requires a license that must be purchased from Altova. Altova's Enterprise XML
Suite and Professional XML Suite products each includes the SchemaAgent Client
product and a license key for it. (The SchemaAgent Server application, however, is not
included in the XML Suite packages.) You can get to work directly, using the 
LocalServer that is included in the SchemaAgent package and installed when you
install SchemaAgent.

· Optionally download SchemaAgent Server from the SchemaAgent download page at
the Altova website and install it anywhere on your network. SchemaAgent Server is
available free of charge.

· Define the search path/s for a SchemaAgent server (either LocalServer or
SchemaAgent Server). A detailed description of how to do this is given in the
SchemaAgent Server documentation.

· Start a connection from within XMLSpy to a SchemaAgent server (either LocalServer
or SchemaAgent Server). 

A detailed description of how to use SchemaAgent functionality in XMLSpy is given in the
XMLSpy documentation.

http://www.altova.com/download_schemaagent.html
http://www.altova.com/download_schemaagent.html
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8 License Information

This section contains:
 

· Information about the distribution of this software product
· Information about the copyrights related to this software product
· The End User License Agreement governing the use of this software product

Please read this information carefully. It is binding upon you since you agreed to these terms
when you installed this software product.
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8.1 Electronic Software Distribution

This product is available through electronic software distribution, a distribution method that
provides the following unique benefits:

 

· You can evaluate the software free-of-charge before making a purchasing decision.
· Once you decide to buy the software, you can place your order online at the Altova

website and immediately get a fully licensed product within minutes.
· When you place an online order, you always get the latest version of our software.
· The product package includes a comprehensive integrated onscreen help system. The

latest version of the user manual is available at www.altova.com (i) in HTML format for
online browsing, and (ii) in PDF format for download (and to print if you prefer to have
the documentation on paper).

30-day evaluation period
After downloading this product, you can evaluate it for a period of up to 30 days free of charge.
About 20 days into this evaluation period, the software will start to remind you that it has not yet
been licensed. The reminder message will be displayed once each time you start the
application. If you would like to continue using the program after the 30-day evaluation period,
you have to purchase an End User License Agreement, which is delivered in the form of a
key-code that you enter into the Registration dialog to unlock the product. You can purchase
your license at the online shop at the Altova website. 

Distributing the product
If you wish to share the product with others, please make sure that you distribute only the
installation program, which is a convenient package that will install the application together with
all sample files and the onscreen help. Any person that receives the product from you is also
automatically entitled to a 30-day evaluation period. After the expiration of this period, any other
user must also purchase a license in order to be able to continue using the product.

For further details, please refer to the End User License Agreement at the end of this section.

http://www.altova.com/
http://www.altova.com/
http://www.altova.com/support_help.html
http://www.altova.com/
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8.2 License Metering

Your Altova product has a built-in license metering module that helps you avoid any
unintentional violation of the End User License Agreement. Your product is licensed either as a
single-user or multi-user installation, and the license-metering module makes sure that no more
than the licensed number of users use the application concurrently.

This license-metering technology uses your local area network (LAN) to communicate between
instances of the application running on different computers. 

Single license 
When the application starts up, it sends a short broadcast datagram to find any other instance
of the product running on another computer in the same network segment. If it doesn't get any
response, it will open a port for listening to other instances of the application. Other than that, it
will not attempt to communicate over a network. If you are not connected to a LAN, or are using
dial-up connections to connect to the Internet, the application will not generate any network
traffic at all.

Multi license
If more than one instance of the application is used within the same LAN, these instances will
briefly communicate with each other on startup. These instances exchange key-codes in order
to ensure that the number of concurrent licenses purchased is not accidentally violated. This is
the same kind of license metering technology that is common in the Unix world and with a
number of database development tools. It allows Altova customers to purchase
reasonably-priced concurrent-use multi-user licenses..

Please note that your Altova product at no time attempts to send any information out of your
LAN or over the Internet. We have also designed the applications so that they send few and
small network packets so as to not put a burden on your network. The TCP/IP ports (2799)
used by your Altova product are officially registered with the IANA (see
http://www.isi.edu/in-notes/iana/assignments/port-numbers for details) and our license-metering
module is tested and proven technology.

If you are using a firewall, you may notice communications on port 2799 between the computers
that are running Altova products. You are, of course, free to block such traffic between different
groups in your organization, as long as you can ensure by other means, that your license
agreement is not violated.

You will also notice that, if you are online, your Altova product contains many useful functions;
these are unrelated to the license-metering technology.

http://www.isi.edu/in-notes/iana/assignments/port-numbers
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8.3 Copyright

All title and copyrights in this software product (including but not limited to images, photographs,
animations, video, audio, music, text, and applets incorporated in the product), in the
accompanying printed materials, and in any copies of these printed materials are owned by
Altova GmbH or the respective supplier. This software product is protected by copyright laws
and international treaty provisions.

· This software product ©1998-2006 Altova GmbH. All rights reserved.
· The Sentry Spelling-Checker Engine © 2000 Wintertree Software Inc. 
· STLport © 1999, 2000 Boris Fomitchev, © 1994 Hewlett-Packard Company, © 1996,

1997 Silicon Graphics Computer Systems, Inc, © 1997 Moscow Center for SPARC
Technology.

· Scintilla © 1998–2002 Neil Hodgson <neilh@scintilla.org>.

· "ANTLR Copyright © 1989-2005 by Terence Parr (www.antlr.org)" 

All other names or trademarks are the property of their respective owners.
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8.4 Altova End User License Agreement

THIS IS A LEGAL DOCUMENT -- RETAIN FOR YOUR RECORDS

ALTOVA® END USER LICENSE AGREEMENT

Licensor:

Altova GmbH
Rudolfsplatz 13a/9
A-1010 Wien
Austria

Important - Read Carefully. Notice to User:
This End User License Agreement ("Software License Agreement") is a legal document
between you and Altova GmbH ("Altova"). It is important that you read this document
before using the Altova-provided software ("Software") and any accompanying
documentation, including, without limitation printed materials, 'online' files, or electronic
documentation ("Documentation"). By clicking the "I accept" and "Next" buttons below,
or by installing, or otherwise using the Software, you agree to be bound by the terms of
this Software License Agreement as well as the Altova Privacy Policy ("Privacy Policy")
including, without limitation, the warranty disclaimers, limitation of liability, data use and
termination provisions below, whether or not you decide to purchase the Software. You
agree that this agreement is enforceable like any written agreement negotiated and signed
by you. If you do not agree, you are not licensed to use the Software, and you must destroy any
downloaded copies of the Software in your possession or control. Please go to our Web site at
http://www.altova.com/eula to download and print a copy of this Software License Agreement
for your files and http://www.altova.com/privacy to review the privacy policy.

1. SOFTWARE LICENSE
(a) License Grant. Upon your acceptance of this Software License Agreement Altova
grants you a non-exclusive, non-transferable (except as provided below), limited license to
install and use a copy of the Software on your compatible computer, up to the Permitted Number
of computers. The Permitted Number of computers shall be delineated at such time as you elect
to purchase the Software. During the evaluation period, hereinafter defined, only a single user
may install and use the software on one computer. If you have licensed the Software as part of a
suite of Altova software products (collectively, the "Suite") and have not installed each product
individually, then the Software License Agreement governs your use of all of the software
included in the Suite. If you have licensed SchemaAgent, then the terms and conditions of this
Software License Agreement apply to your use of the SchemaAgent server software
("SchemaAgent Server") included therein, as applicable and you are licensed to use
SchemaAgent Server solely in connection with your use of Altova Software and solely for the
purposes described in the accompanying documentation. In addition, if you have licensed
XMLSpy Enterprise Edition or MapForce Enterprise Edition,  or UModel,  your license to
install and use a copy of the Software as provided herein permits you to generate source code
based on (i) Altova Library modules that are included in the Software (such generated code
hereinafter referred to as  the "Restricted Source Code") and (ii) schemas or mappings that you
create or provide (such code as may be generated from your schema or mapping  source
materials hereinafter referred to as  the "Unrestricted Source Code").  In addition to the rights
granted herein, Altova grants you a non-exclusive, non-transferable, limited license to compile
into executable form the complete generated code comprised of the combination of the
Restricted Source Code and the Unrestricted Source Code, and to use, copy, distribute or license
that executable.  You may not distribute or redistribute, sublicense, sell, or transfer to a third
party the Restricted Source Code, unless said third party already has a license to the Restricted
Source Code through their separate license agreement with Altova or other agreement with

http://www.altova.com/privacy
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Altova. Altova reserves all other rights in and to the Software. With respect to the feature(s) of
UModel that permit reverse-engineering of your own source code or other source code that you
have lawfully obtained, such use by you does not constitute a violation of this Agreement.
Except as otherwise permitted in Section 1(h) reverse engineering of the Software is strictly
prohibited as further detailed therein.
 (b) Server Use. You may install one copy of the Software on your computer file server for
the purpose of downloading and installing the Software onto other computers within your
internal network up to the Permitted Number of computers. If you have licensed .SchemaAgent,
then you may install SchemaAgent Server on any server computer or workstation and use it in
connection with your Software. No other network use is permitted, including without limitation
using the Software either directly or through commands, data or instructions from or to a
computer not part of your internal network, for Internet or Web-hosting services or by any user
not licensed to use this copy of the Software through a valid license from Altova.
(c) Concurrent Use. If you have licensed a "Concurrent-User" version of the Software,
you may install the Software on any compatible computers, up to ten (10) times the Permitted
Number of users, provided that only the Permitted Number of users actually use the Software at
the same time. The Permitted Number of concurrent users shall be delineated at such time as you
elect to purchase the Software licenses. 
(d) Backup and Archival Copies. You may make one backup and one archival copy of
the Software, provided your backup and archival copies are not installed or used on any
computer and further provided that all such copies shall bear the original and unmodified
copyright, patent and other intellectual property markings that appear on or in the Software. You
may not transfer the rights to a backup or archival copy unless you transfer all rights in the
Software as provided under Section 3.
(e) Home Use. You, as the primary user of the computer on which the Software is
installed, may also install the Software on one of your home computers for your use. However,
the Software may not be used on your home computer at the same time as the Software is being
used on the primary computer.
(f) Key Codes, Upgrades and Updates. Prior to your purchase and as part of the
registration for the thirty (30) -day evaluation period, as applicable, you will receive an
evaluation key code. You will receive a purchase key code when you elect to purchase the
Software. The purchase key code will enable you to activate the Software beyond the initial
evaluation period. You may not re-license, reproduce or distribute any key code except with the
express written permission of Altova. If the Software that you have licensed is an upgrade or an
update, then the update replaces all or part of the Software previously licensed. The update or
upgrade and the associated license keys does not constitute the granting of a second license to
the Software in that you may not use the upgrade or update in addition to the Software that it is
replacing. You agree that use of the upgrade of update terminates your license to use the
Software or portion thereof replaced. 
(g) Title. Title to the Software is not transferred to you. Ownership of all copies of the
Software and of copies made by you is vested in Altova, subject to the rights of use granted to
you in this Software License Agreement. As between you and Altova, documents, files,
stylesheets, generated program code  (including the Unrestricted Source Code)  and schemas
that are authored or created by you via your utilization of the Software, in accordance with its
Documentation and the terms of this Software License Agreement, are your property. 
 (h) Reverse Engineering. Except and to the limited extent as may be otherwise
specifically provided by applicable law in the European Union, you may not reverse engineer,
decompile, disassemble or otherwise attempt to discover the source code, underlying ideas,
underlying user interface techniques or algorithms of the Software by any means whatsoever,
directly or indirectly, or disclose any of the foregoing, except to the extent you may be expressly
permitted to decompile under applicable law in the European Union, if it is essential to do so in
order to achieve operability of the Software with another software program, and you have first
requested Altova to provide the information necessary to achieve such operability and Altova
has not made such information available. Altova has the right to impose reasonable conditions
and to request a reasonable fee before providing such information. Any information supplied by
Altova or obtained by you, as permitted hereunder, may only be used by you for the purpose
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described herein and may not be disclosed to any third party or used to create any software
which is substantially similar to the expression of the Software. Requests for information from
users in the European Union with respect to the above should be directed to the Altova
Customer Support Department. 
(i) Other Restrictions. You may not loan, rent, lease, sublicense, distribute or otherwise
transfer all or any portion of the Software to third parties except to the limited extent set forth in
Section 3 or otherwise expressly provided. You may not copy the Software except as expressly
set forth above, and any copies that you are permitted to make pursuant to this Software License
Agreement must contain the same copyright, patent and other intellectual property markings that
appear on or in the Software. You may not modify, adapt or translate the Software. You may
not, directly or indirectly, encumber or suffer to exist any lien or security interest on the
Software; knowingly take any action that would cause the Software to be placed in the public
domain; or use the Software in any computer environment not specified in this Software License
Agreement. You will comply with applicable law and Altova's instructions regarding the use of
the Software. You agree to notify your employees and agents who may have access to the
Software of the restrictions contained in this Software License Agreement and to ensure their
compliance with these restrictions. you agree that you are solely responsible for the accuracy and
adequacy of the software for your intended use and you will indemnify and HOLD harmless
ALTOVA from any 3rd party suit to the extent based upon the accuracy and adequacy of the
software in your use. without limitation, The Software is not intended for use in the operation of
nuclear facilities, aircraft navigation, communication systems or air traffic control equipment,
where the failure of the Software could lead to death, personal injury or severe physical or
environmental damage.

2. INTELLECTUAL PROPERTY RIGHTS
Acknowledgement of Altova's Rights. You acknowledge that the Software and any copies that
you are authorized by Altova to make are the intellectual property of and are owned by Altova
and its suppliers. The structure, organization and code of the Software are the valuable trade
secrets and confidential information of Altova and its suppliers. The Software is protected by
copyright, including without limitation by United States Copyright Law, international treaty
provisions and applicable laws in the country in which it is being used. You acknowledge that
Altova retains the ownership of all patents, copyrights, trade secrets, trademarks and other
intellectual property rights pertaining to the Software, and that Altova's ownership rights extend
to any images, photographs, animations, videos, audio, music, text and "applets" incorporated
into the Software and all accompanying printed materials. You will take no actions which
adversely affect Altova's intellectual property rights in the Software. Trademarks shall be used in
accordance with accepted trademark practice, including identification of trademark owners'
names. Trademarks may only be used to identify printed output produced by the Software, and
such use of any trademark does not give you any right of ownership in that trademark. XMLSpy,
Authentic, StyleVision, MapForce, Markup Your Mind, Axad, Nanonull, and Altova are
trademarks of Altova GmbH (registered in numerous countries). Unicode and the Unicode Logo
are trademarks of Unicode, Inc. Windows, Windows 95, Windows 98, Windows NT, Windows
2000 and Windows XP are trademarks of Microsoft. W3C, CSS, DOM, MathML, RDF,
XHTML, XML and XSL are trademarks (registered in numerous countries) of the World Wide
Web Consortium (W3C); marks of the W3C are registered and held by its host institutions, MIT,
INRIA and Keio. Except as expressly stated above, this Software License Agreement does not
grant you any intellectual property rights in the Software. Notifications of claimed copyright
infringement should be sent to Altova's copyright agent as further provided on the Altova Web
Site.

3. LIMITED TRANSFER RIGHTS
Notwithstanding the foregoing, you may transfer all your rights to use the Software to another
person or legal entity provided that: (a) you also transfer each of this Software License
Agreement, the Software and all other software or hardware bundled or pre-installed with the
Software, including all copies, updates and prior versions, and all copies of font software
converted into other formats, to such person or entity; (b) you retain no copies, including
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backups and copies stored on a computer; (c) the receiving party secures a personalized key
code from Altova; and (d) the receiving party accepts the terms and conditions of this Software
License Agreement and any other terms and conditions upon which you legally purchased a
license to the Software. Notwithstanding the foregoing, you may not transfer education,
pre-release, or not-for-resale copies of the Software.

4. PRE-RELEASE AND EVALUATION PRODUCT ADDITIONAL TERMS
If the product you have received with this license is pre-commercial release or beta Software
("Pre-release Software"), then this Section applies. In addition, this section applies to all
evaluation and/or demonstration copies of Altova software ("Evaluation Software") and
continues in effect until you purchase a license. To the extent that any provision in this section is
in conflict with any other term or condition in this Software License Agreement, this section
shall supersede such other term(s) and condition(s) with respect to the Pre-release and/or
Evaluation Software, but only to the extent necessary to resolve the conflict. You acknowledge
that the Pre-release Software is a pre-release version, does not represent final product from
Altova, and may contain bugs, errors and other problems that could cause system or other
failures and data loss. CONSEQUENTLY, THE PRE-RELEASE AND/OR EVALUATION
SOFTWARE IS PROVIDED TO YOU "AS-IS" WITH NO WARRANTIES FOR USE OR
PERFORMANCE, AND ALTOVA DISCLAIMS ANY WARRANTY OR LIABILITY
OBLIGATIONS TO YOU OF ANY KIND, WHETHER EXPRESS OR IMPLIED. WHERE
LEGALLY LIABILITY CANNOT BE EXCLUDED FOR PRE-RELEASE AND/OR
EVALUATION SOFTWARE, BUT IT MAY BE LIMITED, ALTOVA'S LIABILITY AND
THAT OF ITS SUPPLIERS SHALL BE LIMITED TO THE SUM OF FIFTY DOLLARS
(USD $50) IN TOTAL. If the Evaluation Software has a time-out feature, then the software will
cease operation after the conclusion of the designated evaluation period. Upon such expiration
date, your license will expire unless otherwise extended. Access to any files created with the
Evaluation Software is entirely at your risk. You acknowledge that Altova has not promised or
guaranteed to you that Pre-release Software will be announced or made available to anyone in
the future, that Altova has no express or implied obligation to you to announce or introduce the
Pre-release Software, and that Altova may not introduce a product similar to or compatible with
the Pre-release Software. Accordingly, you acknowledge that any research or development that
you perform regarding the Pre-release Software or any product associated with the Pre-release
Software is done entirely at your own risk. During the term of this Software License Agreement,
if requested by Altova, you will provide feedback to Altova regarding testing and use of the
Pre-release Software, including error or bug reports. If you have been provided the Pre-release
Software pursuant to a separate written agreement, your use of the Software is governed by such
agreement. You may not sublicense, lease, loan, rent, distribute or otherwise transfer the
Pre-release Software. Upon receipt of a later unreleased version of the Pre-release Software or
release by Altova of a publicly released commercial version of the Software, whether as a
stand-alone product or as part of a larger product, you agree to return or destroy all earlier
Pre-release Software received from Altova and to abide by the terms of the license agreement
for any such later versions of the Pre-release Software. 

5. LIMITED WARRANTY AND LIMITATION OF LIABILITY
(a) Limited Warranty and Customer Remedies. Altova warrants to the person or entity
that first purchases a license for use of the Software pursuant to the terms of this Software
License Agreement that (i) the Software will perform substantially in accordance with any
accompanying Documentation for a period of ninety (90) days from the date of receipt, and (ii)
any support services provided by Altova shall be substantially as described in Section 6 of this
agreement. Some states and jurisdictions do not allow limitations on duration of an implied
warranty, so the above limitation may not apply to you. To the extent allowed by applicable law,
implied warranties on the Software, if any, are limited to ninety (90) days. Altova's and its
suppliers' entire liability and your exclusive remedy shall be, at Altova's option, either (i) return
of the price paid, if any, or (ii) repair or replacement of the Software that does not meet Altova's
Limited Warranty and which is returned to Altova with a copy of your receipt. This Limited
Warranty is void if failure of the Software has resulted from accident, abuse, misapplication,
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abnormal use, Trojan horse, virus, or any other malicious external code. Any replacement
Software will be warranted for the remainder of the original warranty period or thirty (30) days,
whichever is longer. This limited warranty does not apply to Evaluation and/or Pre-release
Software. 
 (b) No Other Warranties and Disclaimer. THE FOREGOING LIMITED WARRANTY
AND REMEDIES STATE THE SOLE AND EXCLUSIVE REMEDIES FOR ALTOVA OR
ITS SUPPLIER'S BREACH OF WARRANTY. ALTOVA AND ITS SUPPLIERS DO NOT
AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY
USING THE SOFTWARE. EXCEPT FOR THE FOREGOING LIMITED WARRANTY, AND
FOR ANY WARRANTY, CONDITION, REPRESENTATION OR TERM TO THE EXTENT
WHICH THE SAME CANNOT OR MAY NOT BE EXCLUDED OR LIMITED BY LAW
APPLICABLE TO YOU IN YOUR JURISDICTION, ALTOVA AND ITS SUPPLIERS
MAKE NO WARRANTIES, CONDITIONS, REPRESENTATIONS OR TERMS, EXPRESS
OR IMPLIED, WHETHER BY STATUTE, COMMON LAW, CUSTOM, USAGE OR
OTHERWISE AS TO ANY OTHER MATTERS. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, ALTOVA AND ITS SUPPLIERS DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, SATISFACTORY
QUALITY, INFORMATIONAL CONTENT OR ACCURACY, QUIET ENJOYMENT, TITLE
AND NON-INFRINGEMENT, WITH REGARD TO THE SOFTWARE, AND THE
PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES. THIS LIMITED
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS,
WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION. 
 (c) Limitation Of Liability. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW EVEN IF A REMEDY FAILS ITS ESSENTIAL PURPOSE, IN NO
EVENT SHALL ALTOVA OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, DIRECT, INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE
SOFTWARE OR THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES,
EVEN IF ALTOVA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
IN ANY CASE, ALTOVA'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS
SOFTWARE LICENSE AGREEMENT SHALL BE LIMITED TO THE AMOUNT
ACTUALLY PAID BY YOU FOR THE SOFTWARE PRODUCT. Because some states and
jurisdictions do not allow the exclusion or limitation of liability, the above limitation may not
apply to you. In such states and jurisdictions, Altova's liability shall be limited to the greatest
extent permitted by law and the limitations or exclusions of warranties and liability contained
herein do not prejudice applicable statutory consumer rights of person acquiring goods
otherwise than in the course of business. The disclaimer and limited liability above are
fundamental to this Software License Agreement between Altova and you.
 (d) Infringement Claims. Altova will indemnify and hold you harmless and will defend or
settle any claim, suit or proceeding brought against you by a third party that is based upon a
claim that the content contained in the Software infringes a copyright or violates an intellectual
or proprietary right protected by United States or European Union law ("Claim"), but only to the
extent the Claim arises directly out of the use of the Software and subject to the limitations set
forth in Section 5 of this Agreement except as otherwise expressly provided. You must notify
Altova in writing of any Claim within ten (10) business days after you first receive notice of the
Claim, and you shall provide to Altova at no cost with such assistance and cooperation as Altova
may reasonably request from time to time in connection with the defense of the Claim. Altova
shall have sole control over any Claim (including, without limitation, the selection of counsel
and the right to settle on your behalf on any terms Altova deems desirable in the sole exercise of
its discretion). You may, at your sole cost, retain separate counsel and participate in the defense
or settlement negotiations. Altova shall pay actual damages, costs, and attorney fees awarded
against you (or payable by you pursuant to a settlement agreement) in connection with a Claim
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to the extent such direct damages and costs are not reimbursed to you by insurance or a third
party, to an aggregate maximum equal to the purchase price of the Software. If the Software or
its use becomes the subject of a Claim or its use is enjoined, or if in the opinion of Altova's legal
counsel the Software is likely to become the subject of a Claim, Altova shall attempt to resolve
the Claim by using commercially reasonable efforts to modify the Software or obtain a license to
continue using the Software. If in the opinion of Altova's legal counsel the Claim, the injunction
or potential Claim cannot be resolved through reasonable modification or licensing, Altova, at
its own election, may terminate this Software License Agreement without penalty, and will
refund to you on a pro rata basis any fees paid in advance by you to Altova. THE FOREGOING
CONSTITUTES ALTOVA'S SOLE AND EXCLUSIVE LIABILITY FOR INTELLECTUAL
PROPERTY INFRINGEMENT. This indemnity does not apply to infringements that would not
be such, except for customer-supplied elements.

6. SUPPORT AND MAINTENANCE
Altova offers multiple optional "Support & Maintenance Package(s)" ("SMP") for the version of
Software product edition that you have licensed, which you may elect to purchase in addition to
your Software license. The Support Period, hereinafter defined, covered by such SMP shall be
delineated at such time as you elect to purchase a SMP. Your rights with respect to support and
maintenance as well as your upgrade eligibility depend on your decision to purchase SMP and
the level of SMP that you have purchased:
(a) If you have not purchased SMP, you will receive the Software AS IS and will not
receive any maintenance releases or updates. However, Altova, at its option and in its sole
discretion on a case by case basis, may decide to offer maintenance releases to you as a courtesy,
but these maintenance releases will not include any new features in excess of the feature set at
the time of your purchase of the Software. In addition, Altova will provide free technical support
to you for thirty (30) days after the date of your purchase (the "Support Period" for the purposes
of this paragraph a), and Altova, in its sole discretion on a case by case basis, may also provide
free courtesy technical support during your thirty (30)-day evaluation period. Technical support
is provided via a Web-based support form only, and there is no guaranteed response time.
(b) If you have purchased SMP, then solely for the duration of its delineated Support
Period, you are eligible to receive the version of the Software edition that you have licensed
and all maintenance releases and updates for that edition that are released during your Support
Period. For the duration of your SMP's Support Period, you will also be eligible to receive
upgrades to the comparable edition of the next version of the Software that succeeds the
Software edition that you have licensed for applicable upgrades released during your Support
Period. The specific upgrade edition that you are eligible to receive based on your Support
Period is further detailed in the SMP that you have purchased. Software that is introduced as
separate product is not included in SMP. Maintenance releases, updates and upgrades may or
may not include additional features. In addition, Altova will provide Priority Technical Support
to you for the duration of the Support Period. Priority Technical Support is provided via a
Web-based support form only, and Altova will make commercially reasonable efforts to respond
via e-mail to all requests within forty-eight (48) hours during Altova's business hours (MO-FR,
8am UTC – 10pm UTC, Austrian and US holidays excluded) and to make reasonable efforts to
provide work-arounds to errors reported in the Software. 

During the Support Period you may also report any Software problem or error to Altova. If
Altova determines that a reported reproducible material error in the Software exists and
significantly impairs the usability and utility of the Software, Altova agrees to use reasonable
commercial efforts to correct or provide a usable work-around solution in an upcoming
maintenance release or update, which is made available at certain times at Altova's sole

discretion.
If Altova, in its discretion, requests written verification of an error or malfunction discovered by
you or requests supporting example files that exhibit the Software problem, you shall promptly
provide such verification or files, by email, telecopy, or overnight mail, setting forth in
reasonable detail the respects in which the Software fails to perform. You shall use reasonable
efforts to cooperate in diagnosis or study of errors. Altova may include error corrections in
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maintenance releases, updates, or new major releases of the Software. Altova is not obligated to
fix errors that are immaterial. Immaterial errors are those that do not significantly impact use of
the Software. Whether or not you have purchased the Support & Maintenance Package,
technical support only covers issues or questions resulting directly out of the operation of the
Software and Altova will not provide you with generic consultation, assistance, or advice under
any circumstances.
Updating Software may require the updating of software not covered by this Software License
Agreement before installation. Updates of the operating system and application software not
specifically covered by this Software License Agreement are your responsibility and will not be
provided by Altova under this Software License Agreement. Altova's obligations under this
Section 6 are contingent upon your proper use of the Software and your compliance with the
terms and conditions of this Software License Agreement at all times. Altova shall be under no
obligation to provide the above technical support if, in Altova's opinion, the Software has failed
due to the following conditions: (i) damage caused by the relocation of the software to another
location or CPU; (ii) alterations, modifications or attempts to change the Software without
Altova's written approval; (iii) causes external to the Software, such as natural disasters, the
failure or fluctuation of electrical power, or computer equipment failure; (iv) your failure to
maintain the Software at Altova's specified release level; or (v) use of the Software with other
software without Altova's prior written approval. It will be your sole responsibility to: (i) comply
with all Altova-specified operating and troubleshooting procedures and then notify Altova
immediately of Software malfunction and provide Altova with complete information thereof; (ii)
provide for the security of your confidential information; (iii) establish and maintain backup
systems and procedures necessary to reconstruct lost or altered files, data or programs.

7. SOFTWARE ACTIVATION, UPDATES AND LICENSE METERING
(a) License Metering. Altova has a built-in license metering module that helps you to
avoid any unintentional violation of this Software License Agreement. Altova may use your
internal network for license metering between installed versions of the Software.
(b) Software Activation. Altova's Software may use your internal network and
Internet connection for the purpose of transmitting license-related data at the time of
installation, registration or update to an Altova-operated license server and validating the
authenticity of the license-related data in order to protect Altova against unlicensed or
illegal use of the Software and to improve customer service.  Activation is based on the
exchange of license related data between your computer and the Altova license server. You
agree that Altova may use these measures and you agree to follow any applicable
requirements.
(c) LiveUpdate. Altova provides a new LiveUpdate notification service to you, which is
free of charge. Altova may use your internal network and Internet connection for the purpose of
transmitting license-related data to an Altova-operated LiveUpdate server to validate your
license at appropriate intervals and determine if there is any update available for you. 
(d) Use of Data. The terms and conditions of the Privacy Policy are set out in full at
http://www.altova.com/privacy and are incorporated by reference into this Software License
Agreement. By your acceptance of the terms of this Software License Agreement or use of the
Software, you authorize the collection, use and disclosure of information collected by Altova for
the purposes provided for in this Software License Agreement and/or the Privacy Policy as
revised from time to time. European users understand and consent to the processing of personal
information in the United States for the purposes described herein. Altova has the right in its
sole discretion to amend   this provision of the  Software License Agreement and/or Privacy
Policy at any time. You are encouraged to review the terms of the Privacy Policy as posted on
the Altova Web site from time to time. 

8. TERM AND TERMINATION
This Software License Agreement may be terminated (a) by your giving Altova written notice of
termination; or (b) by Altova, at its option, giving you written notice of termination if you
commit a breach of this Software License Agreement and fail to cure such breach within ten (10)
days after notice from Altova. In addition the Software License Agreement governing your use

http://www.altova.com/privacy
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of a previous version that you have upgraded or updated of the Software is terminated upon your
acceptance of the terms and conditions of the Software License Agreement accompanying such
upgrade or update. Upon any termination of the Software License Agreement, you must cease all
use of the Software that it governs, destroy all copies then in your possession or control and take
such other actions as Altova may reasonably request to ensure that no copies of the Software
remain in your possession or control. The terms and conditions set forth in Sections 1(g), (h), (i),
2, 5(b), (c), 9, and 10 survive termination as applicable.

9. RESTRICTED RIGHTS NOTICE AND EXPORT RESTRICTIONS 
The Software was developed entirely at private expense and is commercial computer software
provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S.
Government or a U.S. Government contractor or subcontractor is subject to the restrictions set
forth in this Agreement and as provided in FAR 12.211 and 12.212 (48 C.F.R. §12.211 and
12.212) or DFARS 227. 7202 (48 C.F.R. §227-7202) as applicable. Consistent with the above
as applicable, Commercial Computer Software and Commercial Computer Documentation
licensed to U.S. government end users only as commercial items and only with those rights as
are granted to all other end users under the terms and conditions set forth in this Software
License Agreement. Manufacturer is Altova GmbH, Rudolfsplatz, 13a/9, A-1010 Vienna,
Austria/EU. You may not use or otherwise export or re-export the Software or Documentation
except as authorized by United States law and the laws of the jurisdiction in which the Software
was obtained. In particular, but without limitation, the Software or Documentation may not be
exported or re-exported (i) into (or to a national or resident of) any U.S. embargoed country or
(ii) to anyone on the U.S. Treasury Department's list of Specially Designated Nationals or the
U.S. Department of Commerce's Table of Denial Orders. By using the Software, you represent
and warrant that you are not located in, under control of, or a national or resident of any such
country or on any such list.

10. GENERAL PROVISIONS
If you are located in the European Union and are using the Software in the European Union and
not in the United States, then this Software License Agreement will be governed by and
construed in accordance with the laws of the Republic of Austria (excluding its conflict of laws
principles and the U.N. Convention on Contracts for the International Sale of Goods) and you
expressly agree that exclusive jurisdiction for any claim or dispute with Altova or relating in any
way to your use of the Software resides in the Handelsgericht, Wien (Commercial Court,
Vienna) and  you further agree and expressly consent to the exercise of personal jurisdiction in
the Handelsgericht, Wien (Commercial Court, Vienna) in connection with any such dispute or
claim. 
If you are located in the United States or are using the Software in the United States then this
Software License Agreement will be governed by and construed in accordance with the laws of
the Commonwealth of Massachusetts, USA (excluding its conflict of laws principles and the
U.N. Convention on Contracts for the International Sale of Goods) and you expressly agree that
exclusive jurisdiction for any claim or dispute with Altova or relating in any way to your use of
the Software resides in the federal or state courts of Massachusetts and you further agree and
expressly consent to the exercise of personal jurisdiction in the federal or state courts of
Massachusetts in connection with any such dispute or claim.
 If you are located outside of the European Union or the United States and are not using the
Software in the United States, then this Software License Agreement will be governed by and
construed in accordance with the laws of the Republic of Austria (excluding its conflict of laws
principles and the U.N. Convention on Contracts for the International Sale of Goods) and you
expressly agree that exclusive jurisdiction for any claim or dispute with Altova or relating in any
way to your use of the Software resides in the Handelsgericht, Wien (Commercial Court,
Vienna) and you further agree and expressly consent to the exercise of personal jurisdiction in
the Handelsgericht Wien (Commercial Court, Vienna)  in connection with any such dispute or
claim. This Software License Agreement will not be governed by the conflict of law rules of any
jurisdiction or the United Nations Convention on Contracts for the International Sale of Goods,
the application of which is expressly excluded. 
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This Software License Agreement contains the entire agreement and understanding of the parties
with respect to the subject matter hereof, and supersedes all prior written and oral
understandings of the parties with respect to the subject matter hereof. Any notice or other
communication given under this Software License Agreement shall be in writing and shall have
been properly given by either of us to the other if sent by certified or registered mail, return
receipt requested, or by overnight courier to the address shown on Altova's Web site for Altova
and the address shown in Altova's records for you, or such other address as the parties may
designate by notice given in the manner set forth above. This Software License Agreement will
bind and inure to the benefit of the parties and our respective heirs, personal and legal
representatives, affiliates, successors and permitted assigns. The failure of either of us at any
time to require performance of any provision hereof shall in no manner affect such party's right
at a later time to enforce the same or any other term of this Software License Agreement. This
Software License Agreement may be amended only by a document in writing signed by both of
us. In the event of a breach or threatened breach of this Software License Agreement by either
party, the other shall have all applicable equitable as well as legal remedies. Each party is duly
authorized and empowered to enter into and perform this Software License Agreement. If, for
any reason, any provision of this Software License Agreement is held invalid or otherwise
unenforceable, such invalidity or unenforceability shall not affect the remainder of this Software
License Agreement, and this Software License Agreement shall continue in full force and effect
to the fullest extent allowed by law. The parties knowingly and expressly consent to the
foregoing terms and conditions.

Last updated: 2005-05-05
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